DE3.1.2.3.11 – Specification of AXMEDIS Programme and Publication Tools

Automating Production of Cross Media Content for Multi-channel Distribution

www.AXMEDIS.org

DE3.1.2.3.11
Specification of AXMEDIS Programme and Publication Tools
update of DE3.1.2.2.11

Version: 0.6
Date: 12-07-2007

Responsible: UNIVLEEDS (kia@computer.org) (revised and approved by coordinator)

<table>
<thead>
<tr>
<th>Project Number: IST-2-511299</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Title: AXMEDIS</td>
</tr>
<tr>
<td>Deliverable Type: Report</td>
</tr>
<tr>
<td>Visible to User Groups: yes</td>
</tr>
<tr>
<td>Visible to Affiliated: yes</td>
</tr>
<tr>
<td>Visible to the Public: yes</td>
</tr>
</tbody>
</table>

| Deliverable Number: DE3.1.2.3.11 |
| Contractual Date of Delivery: M34 |
| Actual Date of Delivery: 23/07/2007 |
| Title of Deliverable: Specification of AXMEDIS Programme and Publication Tools |
| Work-Package contributing to the Deliverable: WP1, WP2, WP3, WP4, WP5, WP11 |
| Task contributing to the Deliverable: all of WP above |
| Nature of the Deliverable: Report |
| Author(s): UNIVLEEDS |

Abstract: this part includes the specification of components, formats, databases and protocol related to the AXMEDIS Framework area Programme and Publication (P&P) including the P&P Model, P&P Editor, P&P Engine and P&P Engine Monitor.

Keyword List: Programme, Publication, Distribution, Channel, Content, Formatting, On-Demand, Workflow
AXMEDIS Copyright Notice

The following terms (including future possible amendments) set out the rights and obligations licensee will be requested to accept on entering into possession of any official AXMEDIS document either by downloading it from the web site or by any other means.

Any relevant AXMEDIS document includes this license. PLEASE READ THE FOLLOWING TERMS CAREFULLY AS THEY HAVE TO BE ACCEPTED PRIOR TO READING/USE OF THE DOCUMENT.

1. DEFINITIONS

   i. "Acceptance Date" is the date on which these terms and conditions for entering into possession of the document have been accepted.

   ii. "Copyright" stands for any content, document or portion of it that is covered by the copyright disclaimer in a Document.

   iii. "Licensor" is AXMEDIS Consortium as a de-facto consortium of the EC project and any of its derivations in terms of companies and/or associations, see www.axmedis.org.

   iv. "Document" means the information contained in any electronic file, which has been published by the Licensor’s as AXMEDIS official document and listed in the web site mentioned above or available by any other means.

   v. "Works" means any works created by the licensee, which reproduce a Document or any of its part.

2. LICENCE

   1. The Licensor grants a non-exclusive royalty free licence to reproduce and use the Documents subject to present terms and conditions (the Licence) for the parts that are own and proprietary property the of AXMEDIS consortium or its members.

   2. In consideration of the Licensor granting the Licence, licensee agrees to adhere to the following terms and conditions.

3. TERM AND TERMINATION

   1. Granted Licence shall commence on Acceptance Date.

   2. Granted Licence will terminate automatically if licensee fails to comply with any of the terms and conditions of this Licence.

   3. Termination of this Licence does not affect either party’s accrued rights and obligations as at the date of termination.

   4. Upon termination of this Licence for whatever reason, licensee shall cease to make any use of the accessed Copyright.

   5. All provisions of this Licence, which are necessary for the interpretation or enforcement of a party’s rights or obligations, shall survive termination of this Licence and shall continue in full force and effect.

   6. Notwithstanding License termination, confidentiality clauses related to any content, document or part of it as stated in the document itself will remain in force for a period of 5 years after license issue date or the period stated in the document whichever is the longer.

4. USE

   1. Licensee shall not breach or denigrate the integrity of the Copyright Notice and in particular shall not:

      i. remove this Copyright Notice on a Document or any of its reproduction in any form in which those may be achieved;

      ii. change or remove the title of a Document;

      iii. use all or any part of a Document as part of a specification or standard not emanating from the Licensor without the prior written consent of the Licensor; or

      iv. do or permit others to do any act or omission in relation to a Document which is contrary to the rights and obligations as stated in the present license and agreed with the Licensor.

5. COPYRIGHT NOTICES

   1. All Works shall bear a clear notice asserting the Licensor’s Copyright. The notice shall use the wording employed by the Licensor in its own copyright notice unless the Licensor otherwise instructs licensees.
6. **WARRANTY**

1. The Licensor warrants the licensee that the present licence is issued on the basis of full Copyright ownership or re-licensing agreements granting the Licensor full licensing and enforcement power.

2. For the avoidance of doubt the licensee should be aware that although the Copyright in the documents is given under warranty this warranty does not extend to the content of any document which may contain references or specifications or technologies that are covered by patents (also of third parties) or that refer to other standards. AXMEDIS is not responsible and does not guarantee that the information contained in the document is fully proprietary of AXMEDIS consortium and/or partners.

3. Licensee hereby undertakes to the Licensor that he will, without prejudice to any other right of action which the Licensor may have, at all times keep the Licensor fully and effectively indemnified against all and any liability (which liability shall include, without limitation, all losses, costs, claims, expenses, demands, actions, damages, legal and other professional fees and expenses on a full indemnity basis) which the Licensor may suffer or incur as a result of, or by reason of, any breach or non-fulfilment of any of his obligations in respect of this License.

7. **INFRINGEMENT**

1. Licensee undertakes to notify promptly the Licensor of any threatened or actual infringement of the Copyright which comes to licensee notice and shall, at the Licensor’s request and expense, do all such things as are reasonably necessary to defend and enforce the Licensor’s rights in the Copyright.

8. **GOVERNING LAW AND JURISDICTION**

1. This Licence shall be subject to, and construed and interpreted in accordance with Italian law.

2. The parties irrevocably submit to the exclusive jurisdiction of the Italian Courts.

**Please note that:**

- You can become affiliated with AXMEDIS. This will give you the access to a huge amount of knowledge, information and source code related to the AXMEDIS Framework. If you are interested please contact P. Nesi at nesi@dsi.unifi.it. Once affiliated with AXMEDIS you will have the possibility of using the AXMEDIS specification and technology for your business.
- You can contribute to the improvement of AXMEDIS documents and specification by sending the contribution to P. Nesi at nesi@dsi.unifi.it
- You can attend AXMEDIS meetings that are open to public, for additional information see WWW.axmedis.org or contact P. Nesi at nesi@dsi.unifi.it
# Table of Content

## 1 EXECUTIVE SUMMARY AND REPORT SCOPE ................................................................. 6

1.1 OVERVIEW OF THIS PART OF THE AXMEDIS SPECIFICATION DOCUMENT .................... 7
1.2 LIST OF MODULES OR EXECUTABLE TOOLS SPECIFIED IN THIS DOCUMENT ............................ 8
1.3 LIST OF FORMATS SPECIFIED IN THIS DOCUMENT .......................................................... 8
1.4 LIST OF DATABASES SPECIFIED IN THIS DOCUMENT ......................................................... 8
1.5 LIST OF PROTOCOLS SPECIFIED IN THIS DOCUMENT ....................................................... 9

## 2 USE CASES AND SCENARIOS ..................................................................................... 9

2.1 USE CASE 11.1: PROGRAMME AND PUBLICATION PROGRAMME PRODUCTION (UNIVLEEDS) ............................. 9
2.2 USE CASE 11.2: PROGRAMME AND PUBLICATION PROGRAMME EDITING (UNIVLEEDS) ......................... 10
2.3 USE CASE 11.3: ACTIVATION OF PROGRAMME AND PUBLICATION PROGRAMME (UNIVLEEDS) ....................... 11
2.4 USE CASE 11.4: LAUNCH OF PROGRAMME AND PUBLICATION PROGRAMME FROM WORKFLOW (IRC, UNIVLEEDS) .................................................................................................................. 12
2.5 USE CASE 11.5: TRIAL PRE-ACTIVATION OF PROGRAMME AND PUBLICATION PROGRAMME (UNIVLEEDS) .................................................................................................................. 13
2.6 USE CASE 11.6: MONITORING OF PROGRAMME AND PUBLICATION ENGINE (UNIVLEEDS) ................................................. 13

## 3 GENERAL ARCHITECTURE AND RELATIONSHIPS AMONG THE MODULES PRODUCED 14

3.1 P&P PROGRAMME AND PUBLICATION AREA UML DECOMPOSITION ......................................... 15

## 4 EXECUTABLE TOOL PROGRAMME AND PUBLICATION ENGINE (WP5.4.5 UNIVLEEDS) 17

4.1 GENERAL DESCRIPTION OF THE MODULE ........................................................................ 18
4.2 MODULE DESIGN IN TERMS OF CLASSES .................................................................. 20
4.3 USER INTERFACE DESCRIPTION .................................................................................. 20
4.4 TECHNICAL AND INSTALLATION INFORMATION .......................................................... 21
4.5 DRAFT USER MANUAL .................................................................................................. 21
4.6 EXAMPLES OF USAGE .................................................................................................. 21
4.7 INTEGRATION AND COMPILATION ISSUES .................................................................. 21
4.8 CONFIGURATION PARAMETERS ...................................................................................... 21
4.9 ERRORS REPORTED AND THAT MAY OCCUR ................................................................ 22

## 5 EXECUTABLE TOOL PROGRAMME AND PUBLICATION MONITOR (WP5.4.5 UNIVLEEDS) 24

5.1 GENERAL DESCRIPTION OF THE MODULE ........................................................................ 25
5.2 MODULE DESIGN IN TERMS OF CLASSES .................................................................. 26
5.3 USER INTERFACE DESCRIPTION .................................................................................. 26
5.4 TECHNICAL AND INSTALLATION INFORMATION .......................................................... 27
5.5 DRAFT USER MANUAL .................................................................................................. 27
5.6 EXAMPLES OF USAGE .................................................................................................. 28
5.7 INTEGRATION AND COMPILATION ISSUES .................................................................. 28
5.8 CONFIGURATION PARAMETERS ...................................................................................... 28
5.9 ERRORS REPORTED AND THAT MAY OCCUR ................................................................ 29

## 6 EXECUTABLE TOOL PROGRAMME AND PUBLICATION EDITOR .................................. 30

6.1 GENERAL DESCRIPTION OF THE MODULE ........................................................................ 32
6.2 MODULE DESIGN IN TERMS OF CLASSES .................................................................. 33
6.3 USER INTERFACE DESCRIPTION .................................................................................. 34
6.4 TECHNICAL AND INSTALLATION INFORMATION .......................................................... 35
6.5 DRAFT USER MANUAL .................................................................................................. 35
6.6 EXAMPLES OF USAGE .................................................................................................. 40
6.7 INTEGRATION AND COMPILATION ISSUES .................................................................. 40
6.8 CONFIGURATION PARAMETERS ...................................................................................... 40
6.9 ERRORS REPORTED AND THAT MAY OCCUR ................................................................ 42

AXMEDIS Project
### 1 Executive Summary and Report Scope

The full AXMEDIS specification document has been decomposed in the following parts:

<table>
<thead>
<tr>
<th>DE number</th>
<th>Deliverable title</th>
<th>responsible</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE3.1.2.3.1</td>
<td>Specification of General Aspects of AXMEDIS framework</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.2</td>
<td>Specification of AXMEDIS Command Manager</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.3</td>
<td>Specification of AXMEDIS Object Manager and Protection Processor</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.4</td>
<td>Specification of AXMEDIS Editors and Viewers</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.5</td>
<td>Specification of External AXMEDIS Editors/Viewers and Players</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.6</td>
<td>Specification of AXMEDIS Content Processing</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.7</td>
<td>Specification of AXMEDIS External Processing Algorithms</td>
<td>FHGIGD</td>
</tr>
<tr>
<td>DE3.1.2.3.8</td>
<td>Specification of AXMEDIS CMS Crawling Capabilities</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.9</td>
<td>Specification of AXMEDIS database and query support</td>
<td>EXITECH</td>
</tr>
<tr>
<td>DE3.1.2.3.10</td>
<td>Specification of AXMEDIS P2P tools, AXEPTool and AXMEDIS</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.11</td>
<td>Specification of AXMEDIS Programme and Publication tools</td>
<td>UNIVLEEDS</td>
</tr>
<tr>
<td>DE3.1.2.3.12</td>
<td>Specification of AXMEDIS Workflow Tools</td>
<td>UR</td>
</tr>
<tr>
<td>DE3.1.2.3.13</td>
<td>Specification of AXMEDIS Certifier and Supervisor and networks of AXCS</td>
<td>DSI</td>
</tr>
<tr>
<td>DE3.1.2.3.14</td>
<td>Specification of AXMEDIS Protection Support</td>
<td>UPC</td>
</tr>
<tr>
<td>DE3.1.2.3.15</td>
<td>Specification of AXMEDIS accounting and reporting</td>
<td>EXITECH</td>
</tr>
</tbody>
</table>
1.1 Overview of this Part of the AXMEDIS Specification Document

This document, DE3-1-2-3-11 of the above list, is concerned with the Programme and Publication (P&P) area which includes:

- **P&P Editor**: A GUI for users to create, edit, save, and activate P&P Programmes for publication.
- **P&P Engine**: To process and manage distribution of P&P Programmes based upon the distribution rules.
- **P&P Engine Monitor**: A GUI front end to monitor the P&P Engine.
- **P&P Repository for P&P Programmes**

The same engine has to be capable of serving more Distributor Servers to cope with different channels.

**Distributor Profile**:  
- Allowed resource file formats  
- Resolution/size  
- Baud/transfer rate  
- Download/streaming..  
- Governed or not  
- …  

**Client profile**:  
- Allowed resource file formats  
- Resolution/size  
- Baud/transfer rate  
- …
### 1.2 List of Modules or Executable Tools Specified in this document

A module is a component that can be or is reused in other cases or points of the AXMEDIS framework or of other AXMEDIS based solutions.

The modules/tools have to include effective components and/or tools and also testing components and tools.

<table>
<thead>
<tr>
<th>Module/tool Name</th>
<th>Module/Tool Description and purpose, state also in which other AXMEDIS area is used</th>
<th>Standards exploited if any</th>
</tr>
</thead>
<tbody>
<tr>
<td>P&amp;P Model</td>
<td>The P&amp;P Model utilises XERCES and AXMEDIS common libraries. The P&amp;P Model is the backend to edit, load and save a P&amp;P Programme using the P&amp;P Programme schema (axpnprule.xsd)</td>
<td>AXMEDIS common and XERCES v2-6 libraries</td>
</tr>
<tr>
<td>P&amp;P Editor</td>
<td>The P&amp;P Editor is an executable GUI for creating, editing, saving, testing and activating P&amp;P Programme for publication. Other AXMEDIS Modules include P&amp;P Model, AXMEDIS Configuration Manager for application, AXMEDIS Plugin Manager for Workflow, AXMEDIS AXOM for loading AXMEDIS objects, AXMEDIS AXEPTool for uploading and downloading objects</td>
<td>P&amp;P Exploits the P&amp;P Rule Model which utilises AXMEDIS common, gSOAP and XERCES v2-6 libraries (see above)</td>
</tr>
<tr>
<td>P&amp;P Engine</td>
<td>The P&amp;P Engine is an executable GUI for creating, editing, saving, testing and activating P&amp;P Programme for publication. Other AXMEDIS Modules include P&amp;P Model, AXMEDIS Configuration Manager, AXMEDIS Plugin Manager, AXMEDIS AXOM for loading AXMEDIS objects, AXMEDIS AXEPTool for uploading and downloading objects</td>
<td>AXMEDIS Workflow with Webservices, AXDB with Webservices, AXEPTool with Webservices</td>
</tr>
<tr>
<td>P&amp;P Engine Monitor</td>
<td>The P&amp;P Engine Monitor is used to monitor P&amp;P Programmes currently being processed in the P&amp;P Engine by requesting the current P&amp;P Programme for display including the processing information.</td>
<td>AXMEDIS P&amp;P Engine with web services</td>
</tr>
</tbody>
</table>

### 1.3 List of Formats Specified in this document

A format can be (i) an XML content file for modelling some information, (ii) a file format for storing information, (iii) a format that is manipulated by the tools described in this document, etc...

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Description and purpose, state also in which other modules is used</th>
<th>Standards exploited if any</th>
</tr>
</thead>
<tbody>
<tr>
<td>axpnprule.xsd</td>
<td>The P&amp;P Programme format is divided into three rule parts. 1. The header section including the P&amp;P Programme Rule ID (AXRID), 2. The Schedule section specifying when the P&amp;P Programme is to run and complete 3. The Distribution section where the parameters are specified for the what (which object), how (distribution channel, where (the URI) and when (time the object is to be distributed).</td>
<td>XERCES v2-6, gSOAP and the AXMEDIS common libraries</td>
</tr>
</tbody>
</table>

### 1.4 List of Databases Specified in this document

<table>
<thead>
<tr>
<th>Database Name</th>
<th>database Description and purpose, state also in which other AXMEDIS area is using</th>
<th>Standards exploited if any</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXMEDIS Database</td>
<td>The AXDB is accessed using the AXOM loader and saver tools</td>
<td>Webservices</td>
</tr>
</tbody>
</table>

*AXMEDIS Project*
1.5 List of Protocols Specified in this document

A protocol is a communication modality among distinct processes that can be located or not on different computers.

<table>
<thead>
<tr>
<th>Protocol Name</th>
<th>Description and purpose, state also in which other modules is used</th>
<th>Who is the master and who is the slave</th>
<th>Standards exploited if any</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebServices</td>
<td>Webservice calls are used to pass on the workflow request coming from the request adaptor and converting them into a generalised function call towards AXMEDIS Framework using Webservices</td>
<td>Request Gateway – Master AXMEDIS Tools – Slave (P&amp;P Editor and P&amp;P Engine)</td>
<td>Webservice</td>
</tr>
<tr>
<td>WebServices</td>
<td>Webservice calls are also used to pass on the request coming from the AXMEDIS Tools towards the workflow. The calls are received by the response gateways.</td>
<td>Response Gateway – Slave AXMEDIS Tools – Master (P&amp;P Editor and P&amp;P Engine)</td>
<td>Webservice</td>
</tr>
<tr>
<td>WebServices</td>
<td>Webservice calls are also used to pass on P&amp;P Programme activation requests to the P&amp;P Engine. The calls are received by the P&amp;P Engine server.</td>
<td>P&amp;P Editor – Slave P&amp;P Engine – Master</td>
<td>Webservice</td>
</tr>
<tr>
<td>WebServices</td>
<td>Webservice calls are also used to download objects from and upload objects to the P2P network (AXEPTool)</td>
<td>AXEPTool – Master P&amp;P Engine - Slave</td>
<td>Webservice</td>
</tr>
<tr>
<td>WebServices</td>
<td>Webservice calls are also used by the AXMEDIS Database for communicating with the AXDBCP</td>
<td>AXMEDIS Database – Master P&amp;P Engine - Slave</td>
<td>Webservice</td>
</tr>
<tr>
<td>WebServices</td>
<td>Webservice calls are also used by the P&amp;P Engine for communicating with the AXDBCP</td>
<td>AXCP – Master P&amp;P Engine - Slave</td>
<td>Webservice</td>
</tr>
</tbody>
</table>

2 Use Cases and scenarios

The use cases for the P&P Area include:
- Use Case 10.1: Programme and Publication Rules Production
- Use Case 10.2: Programme and Publication Rules Editing
- Use Case 10.3: Activation of Programme and Publication Rules
- Use Case 10.4: Launch of Programme and Publication Rules from Workflow
- Use Case 10.5 Trial Pre-activation of Programme and Publication Rules

2.1 Use Case 11.1: Programme and Publication Programme Production (UNIVLEEDS)

This section describes how the P&P Programme are produced by a Programme Manager (the Actor) to create a new programme for the publication of AXMEDIS Digital Objects over multiple distribution channels such as PDA, PC and satellite.
1. Actor initiates GUI in the Programme and Publication Editor
2. The Actor submits queries to Query Support for a list of AXMEDIS objects
3. Query Support returns a list of AXOIDs (see UCs in section 3.1.2)
4. The Programme and Publication Editor GUI allows the actor to select AXOIDs The Actor specifies what (AXOID), where (channel), when (schedule), etc.
5. The Programme is saved in the Programme and Publication Repository which can be re-used

By default the Programme is “inactive” at the end of the programme production, until the Actor activated/published it. The actor is required to use the Query Support interface to select AXMEDIS objects.

2.2 Use Case 11.2: Programme and Publication Programme Editing (UNIVLEEDS)

This section describes how the Programme and Publication Programme are manipulated by a programme manager to edit the various distribution and schedule parameters specified within the P&P Programme.
1. Actor initiates the P&P GUI
2. (2a) the user browse the existing programmes in the P&P Repository and (2b) selects P&P Programme for a Programme list for (2c) load the selected P&P Programme
3. (3a) Actor queries for additional objects using Query Support (3b). Query Support returns a list of AXOID
4. Actor edits the Programme (e.g. time, channel)
5. The revised P&P Programme is saved to the Programme and Publication Repository as a new Programme or overwriting the original Programme

2.3 Use Case 11.3: Activation of Programme and Publication Programme (UNIVLEEDS)
This section describes how the Programme and Publication Programmes are activated for the publication of AXMEDIS Objects. In this use case the result is the P&P Programme is sent to the P&P Engine which processes the parameters and objects to deliver correctly formatted AXMEDIS Object for the Actor’s specified distribution channel.

1. The actor uses the Programme and Publication Editor GUI
2. If the programme has not been loaded, the user can select and load the programme, for final checking
3. The programme/schedule is returned from the repository
4. A GUI to allow the user to activate/publish the programme (4a) to the P&P Engine (4b)
5. The P&P Editor checks and reports an invalid programme
6. A confirmation on the success of the publication
2.4 Use Case 11.4: Launch of Programme and Publication Programme from Workflow (IRC, UNIVLEEDS)

In this section, the P&P engine is running monitoring the system clock to ensure that one or more scheduled programmes are delivered in time for the actual consumption

1. Workflow sends a P&P programme to be activated
2. The Engine checks if the P&P Programme is already running
   2.1. Engine searches active programmes
   2.2. The matching programme is removed if found
3. Check source and target format
4. If profiles mismatch
   4.1. Send request to AXCP via Workflow
   4.2. Receive new object ID from workflow
   4.3. Update the programme with new object ID
5. Calculate distribution time based on distribution schedule and distribution server profile
6. Programme is scheduled for distribution
7. At their scheduled distribution time
   7.1. Request Objects from AXDB
   7.2. Receive objects (from AXDB according to Scenarios v3.6)
   7.3. Send to Distribution Servers

In this use case there is a variation to the above scenario for content production On-Demand. The On-Demand scenario is sent via workflow and in this case the content is produced only for the requesting
distribution server/terminal and to be processed and distributed immediately. In addition to “Activate” request, Workflow can send:
1. A “Kill” request. In this case, the Engine will remove the scheduled Programme
2. A “List” request. In this case, the Engine will return a list of scheduled programmes
3. A “Status” request. In this case, the Engine will return the status of the relevant scheduled programme.
4.

2.5 Use Case 11.5: Trial Pre-activation of Programme and Publication Programme (UNIVLEEDS)

This section describes how the P&P Programmes are pre-activated to simulate, test and be prepared.
1. Steps 1-4 of the UC11.3 (see section 2.3 Activation of P&P Programme above)
2. The P&P Editor GUI to allow the user to activate/publish the Programme as a trial (quick trial or full trial)
3. A confirmation on the success of the trial-run when completed

There are two trials available, the Quick trial and the Full trial. A quick trial would complete each stage for publication without requiring the engines such as the formatting engine to actually format the object but simply acknowledge if it can format the object from the source object to a given target representation. The full trial completes a publication without final distribution.

2.6 Use Case 11.6: Monitoring of Programme and Publication Engine (UNIVLEEDS)

This use case begins when a programme manager wishes to monitor programmes running on the P&P Engine. The monitor application is launched and the actor can view and manage active P&P programmes.

1. The Actor starts the P&P Engine Monitor which connects to a P&P Engine
2. The P&P Monitor requests a list of active Programmes
3. The P&P Engine returns the current list of Programmes
4. The P&P Monitor updates the GUI window

The variation to this Use Case is that the Actor may select an active P&P programme from the list and “Kill” it. The P&P Engine aborts the Programme and notifies the Workflow that the specific P&P programme has been killed.
3 General architecture and relationships among the modules produced

The AXMEDIS Programme and Publication Area are comprised of three main components plus it utilises the Workflow manager. The P&P Editor is designed for creating, editing and saving P&P Programmes. A P&P Programme consists of the parameters and distribution rules for delivering AXMEDIS objects. The P&P Engine to execute the scheduled P&P Programme and the P&P Monitor for monitoring the P&P engine.

1. **Workflow Manager** – performs the role of supervisor and controlling the P&P Programme and P&P Editor activities.
2. **P&P Programme Editor** – is an editor for scheduling the distribution of AXMEDIS objects. It is supported by a P&P Programme Repository and interacts with the P&P Engine. The editor also uses
3. **P&P Engine** – performs the distribution activities for the scheduled objects in the activated programmes. The P&P engine distributes AXMEDIS objects to the distributor server using their API’s or other defined methods. The P&P Engine interacts with the AXCP to request formatting of AXMEDIS objects if they are not compatible with the distribution channel specified and with the AXDB to retrieve the AXMEDIS objects for distribution.
4. **P&P Monitor** – interacts with the P&P Engine and provides a graphical user interface for actors to monitor the P&P Engine including killing activated P&P Programmes if necessary.
5. **AXDB** – AXMEDIS database is accessed using the AXDB manager object loader to retrieve the AXMEDIS object requested for distribution.
6. **P2P Network (AXEPTool)** – The P2P network is accessed using the WebServices interface provided by the AXEPTool. Using the WebServices, the P&P Engine can download objects from or upload objects to the P2P network.
7. **AXCP** – AXMEDIS Content Processing is used by the P&P Engine to request the formatting of Objects to fit the profile for the distribution channel specified for the distribution of the AXMEDIS Object.

8. **Repository P&P Programmes**: It is a simple repository of programmes; it is the file systems with programmes described by means of an XML schema (axpnprule.xsd).

9. **Active Programmes**: They are programmes that are scheduled to be run by the P&P Engine.

10. **AXMEDIS Database Manager** – It allows the P&P Engine to retrieve AXMEDIS objects involved in the execution of a programme after the request for formatting (if required). The P&P Engine uses the AXMEDIS Object Loader.

11. **AXMEDIS Query Support** – It allows the P&P Editor to submit queries to the AXMEDIS Database Manager to specify objects details including the AXOID to add to a P&P Programme.

### 3.1 P&P Programme and Publication Area UML Decomposition

This section describes the UML decomposition of the AXMEDIS Programme and Publication Area. It represents the complete picture for the Programme and Publication Area.

According to the UML diagram, the AXMEDIS Programme and Publication Area includes:

- **P&P Rule Editor**: A graphic editor that allows the creation, saving and editing of P&P Programmes.
- **Repository of Publication Rules**: It is a simple file system where the Programme and Publication rules (P&P Programme) are described by means of an XML schema (axpnprule.xsd)
- **Active Publication Rules**: They are P&P Programmes scheduled to be run by the Programme and Publication Engine
- **Content Processing Engine**: Allows the P&P Engine to request formatting changes to an AXMEDIS Object to fit the distribution profile for the distribution channel specified in the P&P Programme. This process uses AXMEDIS Workflow Manager and the AXMEDIS Object Manager (AXOM) see DE3-1-2-3-6 Specification of AXMEDIS Content Processing for more details.
- **AXMEDIS Query Support**: It allows the P&P Editor to submit queries to the AXMEDIS Database Manager with the integrated AXMEDIS Selection Editor
- **Distribution Area**: Is the various distribution servers the P&P engine can use through their APIs or other specified means for providing the AXMEDIS Object.
- **Distribution and Client Profile**: Is the information available on the various devices and distribution servers to provide information on how to calculate the distribution time and formatting of the AXMEDIS Object.
- **AXMEDIS Database Manager** – It allows the P&P Engine to retrieve the AXMEDIS objects involved in the execution of the P&P Programme using the AXMEDIS Object Loader and web services.
- **AXEPTool Client**: Is responsible for downloading objects from and uploading objects to the P2P network
The same engine has to be capable of serving more Distributor Servers to cope with different channels

**Distributor Profile:**
- Allowed resource file formats
- Resolution/size
- Baud/transfer rate
- Download/streaming...
- Governed or not
- …

**Client profile:**
- Allowed resource file formats
- Resolution/size
- Baud/transfer rate
- …
### 4 Executable Tool Programme and Publication Engine (WP5.4.5 UNIVLEEDS)

<table>
<thead>
<tr>
<th>Module/Tool Profile</th>
<th>Programme and Publication Engine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsible Name</td>
<td>Kia Ng, Royce Neagle and Minh Thang Dang</td>
</tr>
<tr>
<td>Responsible Partner</td>
<td>UNIVLEEDS</td>
</tr>
<tr>
<td>Status (proposed/approved)</td>
<td>Proposed</td>
</tr>
<tr>
<td>Implemented/not implemented</td>
<td>Implemented</td>
</tr>
<tr>
<td>Status of the implementation</td>
<td>Version 1.0</td>
</tr>
<tr>
<td>Executable or Library/module (Support)</td>
<td>Executable</td>
</tr>
<tr>
<td>Single Thread or Multithread</td>
<td>Multithread</td>
</tr>
<tr>
<td>Language of Development</td>
<td>C++</td>
</tr>
<tr>
<td>Platforms supported</td>
<td>Microsoft Windows XP  Win32</td>
</tr>
<tr>
<td>Reference to the AXFW location of the source code demonstrator</td>
<td><a href="https://cvs.axmedis.org/repos/Application/axpnpeng/source">https://cvs.axmedis.org/repos/Application/axpnpeng/source</a></td>
</tr>
<tr>
<td>Reference to the AXFW location of the demonstrator executable tool for internal download</td>
<td><a href="https://cvs.axmedis.org/repos/Application/axpnpeng/include">https://cvs.axmedis.org/repos/Application/axpnpeng/include</a></td>
</tr>
<tr>
<td>Reference to the AXFW location of the demonstrator executable tool for public download</td>
<td><a href="https://cvs.axmedis.org/repos/Application/axpnpeng/bin/win32/axpnpeng.exe">https://cvs.axmedis.org/repos/Application/axpnpeng/bin/win32/axpnpeng.exe</a></td>
</tr>
<tr>
<td>Address for accessing to WebServices if any, add accession information (user and Passwd) if any</td>
<td>Currently running on local system as multiple engines</td>
</tr>
<tr>
<td>Test cases (present/absent)</td>
<td>Present  (by running the P&amp;P Editor and creating or loading an existing programme from the repository, the Engine can be tested by activating the P&amp;P Programme)</td>
</tr>
<tr>
<td>Test cases location</td>
<td>TC10.3, TC10.4, TC10.5, TC10.6</td>
</tr>
<tr>
<td>Usage of the AXMEDIS configuration manager (yes/no)</td>
<td>Yes</td>
</tr>
<tr>
<td>Usage of the AXMEDIS Error Manager (yes/no)</td>
<td>No</td>
</tr>
<tr>
<td>Major Problems not solved</td>
<td>Optimisation of object delivery according to channel</td>
</tr>
<tr>
<td>Major requirements pending</td>
<td>Full integration with monitor to enable management of Programmes</td>
</tr>
<tr>
<td>Interfaces API with other Name of the communicating tools</td>
<td>Communication model and format</td>
</tr>
<tr>
<td>tools, named as</td>
<td>References to other major components needed</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>P&amp;P Model</td>
<td>AXCP, AXWF, AXOM, AXDB, AXEPTool</td>
</tr>
<tr>
<td>Formats Used</td>
<td>Shared with format name or reference to a section</td>
</tr>
<tr>
<td>XML</td>
<td>P&amp;P Editor, P&amp;P Engine Monitor</td>
</tr>
<tr>
<td>Protocol Used</td>
<td>Shared with Protocol name or reference to a section</td>
</tr>
<tr>
<td>Used Database name</td>
<td></td>
</tr>
<tr>
<td>AXDB</td>
<td></td>
</tr>
<tr>
<td>User Interface</td>
<td>Development model, language, etc.</td>
</tr>
<tr>
<td>Simple CLI on Engine outputs status messages on STDOUT</td>
<td>C++</td>
</tr>
<tr>
<td>Used Libraries</td>
<td>Name of the library and version</td>
</tr>
<tr>
<td>wxWidgets</td>
<td>wxWidgets-2.4</td>
</tr>
<tr>
<td>gSOAP</td>
<td>gSOAP version 2.7.7</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 4.1 General Description of the Module

The Programme and Publication Engine will be developed exploiting the work performed for the Publication tool in WP4.4. This will allow the reception of specific commands (requests) for creating content produced by exploiting the capabilities of the AXMEDIS formatting engine. In addition, the Programme and Publication Engine will also have the capabilities for the publication the Programme based on the specific rules.

The active engine is continuous running software accessing the system clock to process a list of programmes, which consists of “rules” to make available AXMEDIS objects to the specified destination channels at the correct time, taking into account the transfer and/or formatting (if required) time. This is achieved by the input of activated P&P Programme for scheduled distribution.

The active Programme and Publications Engine’s main function is to continually run looking for active publication rules and make the objects in the rules available for distribution. The main points to consider:
• Access to correct system clock
• Keep a track of newly activated P&P Programmes to add to the delivery system
• The API to the AXMEDIS formatting engine to request an appropriate format for distribution and retrieving the correct object from the AXDB or the P2P network.
• Providing the AXMEDIS objects to a AXMEDIS distribution server allowing for delivery time

On Demand for the user is to be done by the Active Engine during the “transfer” schedule, just before the actual AXMEDIS object is to be delivered to the distribution server. A check has to be carried out to see if the object in question is “compatible” with the destination profile. The check could be done when new Programme is “activated” by the actor so that the Engine knows these additional requirements and can allow for necessary formatting time before actual physical delivery. Non-compatible objects require the Programme and Publication Engine to interface with the Formatting engine to provide the appropriate processing to reformat the object for distribution. For example, the AXMEDIS object in the database could be for HDTV and the Programme producer has requested it to be used on a PDA. The Programme and Publication Engine provides the Formatting engine a reference to the AXMEDIS object and the destination profile.

The Formatting engine is expected to
• Take a copy of the AXMEDIS object
• Process/convert/etc the object so that it is compatible to the destination profile
• Deliver it to a Distribution Server or destination

4.1.1. Configuration management
Configuration is handled by the AXMEDIS Configuration Manager. The port that the server listens on is configured here. Otherwise it will default to 3003. The server also listens on port 3004 for the activation of P&P Programmes, port 3005 for Engine Monitor SOAP requests and port 3009 for AXMEDIS Workflow requests. Other configuration includes the connection parameters for the AXMEDIS database, AXEPTool (P2P Client) and AXMEDIS content processing (AXCP).

4.1.2. Please verify if some your components can be produced customizing a component produced by other partners or can used by other partners in other tools
There are no components that could be used of use to other partners at this time

4.1.3. Interoperability on different platforms,
The project is built and tested on Windows XP but uses only portable libraries and code so could easily be made cross platform (provided the code from other partners also supports this).

4.1.4. Print capability of the information manipulated
No support for this. This is not required for this specific module.

4.1.5. Protection aspects (registration, certification, operation control, access to certifier, DRM, etc.), please consult protection experts
No support. This is not required for this specific module.

4.1.6. Help to support the users,
The server is not interactive so it can be started and stopped. No help is needed. The monitor has limited built in help in the GUI which will be expanded as its functions become more complex

4.1.7. Multilingual support of the user interface and of the help
There is currently not scheduled for implemented but the P&P Engine code can be internationalised with the wxWidgets macros

4.1.8. Undo support that could be obtained with controlling all commands
This is not appropriate and not required for this specific module.
4.1.9. Workflow and cooperative work support to be integrated with the Workflow tools that will be selected for AXMEDIS, etc.
The P&P Engine is integrated with workflow with communication and process control such as activation, deletion, and reporting.

4.1.10. Insert an about for citing, copyright, AXMEDIS projects and EC in a proper manner, as will be defined later.
The P&P Engine does not directly interact with the user (but via the Editor and the Monitor) and hence no need to have the “About” dialog as in GUI interface. However, the “About” will be included as command options and start-up option.

4.1.11. Refer to used standards providing references and documents for the other partners. These documents will be made accessible to all via WEB.
The P&P Engine uses the AXMEDIS P&P schema (axpnrule.xsd) which is accessible to all via the web portal. The communications protocol between the P&P Engine and the WF is also accessible to all via the web portal.

4.1.12. Declare any library and tools that you are going to use and the license level/type/cost for that tools/libraries, etc. According to the CA you have to be very carefully in using: wxWidget, Xerces, gSOAP.

4.2 Module Design in terms of Classes

4.3 User interface description
**Engine**
The engine when running is non-interactive. It outputs status messages to the console. See the P&P Engine Monitor concerning the user interface for the P&P Engine.

### 4.4 Technical and Installation information
The compiled versions of axpnpeng and axpnpengmonitor are easy to install.

To run the engine, a copy of the executable axpnpeng.exe must be present along with the following components:

- xerces-c_2_6.dll
- libcurl.dll
- editor-configuration.xml
- configuration.xsd
- AXPNPRULES/axppnrule.xsd
- AXPNPRULES/Selection_v1.6.xsd

### 4.5 Draft User Manual
See next subsection (“Examples of usage”) on how to run the P&P Engine.

See the Draft User Manual for the P&P Engine Monitor (section 5.5 Draft User Manual) for the usage of the Engine which works with the P&P Engine Monitor.

### 4.6 Examples of usage
Run the executable from within the OS (developed and tested under WinXP) by either double clicking the exe file or by typing the path and filename in a DOS command shell.

It will now listen for programme requests from the P&P Editor and Workflow. On receiving a Programme request, the P&P Engine will schedule delivery of the AXMEDIS objects to ensure on-time delivery. The Engine will retrieve the object from the AXDB or the P2P network and deliver it using an appropriate protocol for the target, e.g. FTP. The programme can be aborted at any point by Workflow sending an abort request.

### 4.7 Integration and compilation issues
The .NET preferences are set to find the following libraries and require the environment variables to be set for wxWidget, LibCurl and WsdlPull and Xerces. Control Panel -> System -> Advanced -> Environment Variable

- $(WXWIN) = where wxWindows-2.4.2 is installed
- $(LIBCURL) = where libcurl-devel-7.15.1 is installed
- $(WSDLPULL) = where wsdlpull-1.9 is installed
- $(XERCES) = where xerces-c_2_6_0 is installed
- $(GSOAP) = where gSOAP v2.2.7 is installed

NB if you are building Xerces from source you will have to set XERCESCROOT to where you have installed the source code for Xerces. Building the libraries can be done as a batch build or build individually in the build menu for the Debug and Release libraries.

### 4.8 Configuration Parameters

<table>
<thead>
<tr>
<th>Config parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### AXPNPENGINE
- **PNPURI**
  - Address of the Engine for returned communication messages
- **PORT**
  - Listening port for the P&P Editor using sockets
- **MONITOR_PORT**
  - Listening port for the P&P Engine Monitor using web services
- **PnP_SOAP_PORT**
  - Listening port for the P&P Editor using web services
- **WF_SOAP_PORT**
  - Listening port for Workflow using web services
- **NAME**
  - Software name for other application identification
- **OBJECT_REPOSITORY**
  - Directory for downloaded objects

**PnP_EDITOR**
- **XML XSD_PATH**
  - path-to-executable/plugin

**AXMEDIS_PLUGIN_MANAGER**
- **PLUGINS_PATH**
  - path-to-schemas

**AXMEDIS_SELECTION**
- **MAIN_QUERY_SUPPORT_WSDL**
  - the-url-of-the-wsdl-for-query-support

**AXMEDIS_DATABASE**
- **user**
- **passwd**
- **LoaderWSEndPoint**
  - address_to_database_loader_endpoint

**WORKFLOW**
- **workflowUrl**
- **gatewayUrl**
  - http://<workflow-address>:8080/responseGateway/reChannel/reChannel.asmx

**AXEPTOOL**
- **LoaderWSEndPoint**
- **TrackerURL**
  - URL for the WSDL AXEPTOOL Webservices
  - URL for the P2P Object Tracker for downloading and uploading

**AXMEDIS_DISTRIBUTION_TYPE**
- **<DIST-NAME>_address**
  - FTP Server address
- **<DIST-NAME>_user**
  - FTP User Name
- **<DIST-NAME>_pass**
  - FTP Password
- **<DIST-NAME>_cd**
  - FTP Directory for upload and download

**CONTENT_PROCESSING**
- **WSDLURI**
- **ENGINEURL**
  - URL fo the WSDL for the AXCP Scheduler
  - AXCP Scheduler address and port number

### 4.9 Errors reported and that may occur

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description and rationales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Could not create new wxSocketServer</td>
<td>The engine could not bind to the specified port on start-up</td>
</tr>
<tr>
<td>Accept 0 failed</td>
<td>Socket Accept method failed for programme port</td>
</tr>
<tr>
<td>Accept 1 failed</td>
<td>Socket Accept method failed for monitor port</td>
</tr>
<tr>
<td>Socket Error: Bad on-demand message: content length incorrect</td>
<td>The programme thread has received a message which it can’t handle</td>
</tr>
<tr>
<td>Socket Error: Bad on-demand message format (no space char)</td>
<td>The programme thread has received a message which it can’t handle</td>
</tr>
<tr>
<td>Thread %d requested unavailable file: %s</td>
<td>A programme refers to an AXObject that is not available</td>
</tr>
<tr>
<td>Thread %d can’t open file: %s</td>
<td>The AXObject cannot be opened (appears to be damaged)</td>
</tr>
<tr>
<td>Socket Error: Bad pnp programme message format: content length too short</td>
<td>A P&amp;P Programme was received but was not the same length as the header stated it would be</td>
</tr>
<tr>
<td>Error loading pnp programme</td>
<td>The AxPnPRule object could not parse the P&amp;P Programme</td>
</tr>
<tr>
<td>Error: No object available, unable to execute</td>
<td>The AXObject could not be obtained</td>
</tr>
<tr>
<td>PnP Error: Error loading pnp programme</td>
<td>Error occurred loading and parsing an activated P&amp;P Programme</td>
</tr>
<tr>
<td>Error Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>P2P Error: The file does not exist</td>
<td>The AXObject does not exist for distribution in the Object Repository</td>
</tr>
<tr>
<td>P2P Error: Could not open file</td>
<td>The AxObject could not be opened for distribution</td>
</tr>
<tr>
<td>FTP Error: Could not open file</td>
<td>The AxObject could not be opened for distribution</td>
</tr>
<tr>
<td>AXDB Error: loading unsuccessful</td>
<td>Error occurred loading an AxObject from the AXDB</td>
</tr>
<tr>
<td>AXEPTool Error: loading unsuccessful</td>
<td>Error occurred loading an AxObject from the AXEPTool (P2P Network)</td>
</tr>
<tr>
<td>AXCP Error: WSDL does not exist</td>
<td>WSDL not found for web services</td>
</tr>
<tr>
<td>AXCP Error: Unable to do content processing</td>
<td>An error occurred requesting AXMEDIS content processing</td>
</tr>
<tr>
<td><code>&lt;PLUGIN&gt;</code> DLL Error: <code>&lt;Message&gt;</code></td>
<td>Other error messages defined in the distribution plugins</td>
</tr>
</tbody>
</table>
## Module/Tool Profile

**Programme and Publication Engine Monitor**

<table>
<thead>
<tr>
<th>Responsible Name</th>
<th>Kia Ng, Royce Neagle and Minh Thang Dang</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsible Partner</td>
<td>UNIVLEEDS</td>
</tr>
<tr>
<td>Status (proposed/approved)</td>
<td>proposed</td>
</tr>
<tr>
<td>Implemented/not implemented</td>
<td>Implemented</td>
</tr>
<tr>
<td>Status of the implementation</td>
<td>Version 1.0</td>
</tr>
<tr>
<td>Executable or Library/module (Support)</td>
<td>Executable</td>
</tr>
<tr>
<td>Single Thread or Multithread</td>
<td>Multithread</td>
</tr>
<tr>
<td>Language of Development</td>
<td>C++</td>
</tr>
<tr>
<td>Platforms supported</td>
<td>Microsoft Windows XP  Win32</td>
</tr>
</tbody>
</table>
| Reference to the AXFW location of the source code demonstrator | https://cvs.axmedis.org/repos/Application/axpnpeng/source  
  https://cvs.axmedis.org/repos/Application/axpnpeng/include |
| Reference to the AXFW location of the demonstrator executable tool for internal download | https://cvs.axmedis.org/repos/Application/axpnpeng/bin/win32/axpnpengimeter.exe |
| Reference to the AXFW location of the demonstrator executable tool for public download | ACTIVITIES/WP4 and WP5/General on AXFW and Guidelines/  
| Address for accessing to WebServices if any, add accession information (user and Passwd ) if any |                                |
| Test cases (present/absent)           | Present (testing is achieved in conjunction with the axppeng software) |
| Test cases location                   | TC10.6                                    |
| Usage of the AXMEDIS configuration manager (yes/no) | Yes                                       |
| Usage of the AXMEDIS Error Manager (yes/no) | No                                       |
| Major Problems not solved             |                                           |
| Major requirements pending            | management of programmes as well as monitoring |
| Interfaces API with other tools, named as | Name of the communicating tools References to other major  
  Communication model and format (protected or not, etc.) |
## 5.1 General Description of the Module

This module provides a graphical interface to enable the user to monitor active programmes on the programme and publication engine. The engine is a server and so outputs status messages locally (to screen). The monitor may be on a local or remote machine and can query the engine over the network using Webservices.

The project is built and tested on Windows XP but uses only portable libraries and code so could easily be made cross platform. The P&P Engine Monitor does not use the configuration management system. This is handled by the P&P Engine and only the Engine and P&P Programme monitoring is handled. As a front end GUI for the P&P Engine, the P&P Engine Monitor is not customisable for other partners and other AXMEDIS tools.

<table>
<thead>
<tr>
<th>components needed</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>P&amp;P Engine</strong></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Webservices</td>
</tr>
<tr>
<td><strong>Formats Used</strong></td>
<td>Shared with</td>
</tr>
<tr>
<td></td>
<td>format name or reference to a section</td>
</tr>
<tr>
<td><strong>Protocol Used</strong></td>
<td>Shared with</td>
</tr>
<tr>
<td></td>
<td>Protocol name or reference to a section</td>
</tr>
<tr>
<td><strong>Simple application layer networking protocol to send requests to the engine over Webservices</strong></td>
<td>axpnpengine</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Used Database name</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Interface</strong></td>
<td>Development model, language, etc.</td>
</tr>
<tr>
<td><strong>Graphical user interface provides a tree view of programmes currently active on the server</strong></td>
<td>C++</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Used Libraries</th>
<th>Name of the library and version</th>
<th>License status: GPL, LGPL, PEK, proprietary, authorized or not</th>
</tr>
</thead>
<tbody>
<tr>
<td>wxWidgets</td>
<td>wxWidgets-2.4</td>
<td>wxWindows licence (<a href="http://www.wxwidgets.org/newlicen.htm">http://www.wxwidgets.org/newlicen.htm</a>)</td>
</tr>
<tr>
<td>gSOAP</td>
<td>gSOAP v2.2.7</td>
<td>Can be chosen from gSOAP public license (<a href="http://www.cs.fsu.edu/~engelen/license.html">http://www.cs.fsu.edu/~engelen/license.html</a>), GPL (<a href="http://www.cs.fsu.edu/~engelen/gpl.txt">http://www.cs.fsu.edu/~engelen/gpl.txt</a>), or proprietary software development license (<a href="http://www.genivia.com/Products/gsoap/GeniviaGSoupLicense.pdf">http://www.genivia.com/Products/gsoap/GeniviaGSoupLicense.pdf</a>)</td>
</tr>
</tbody>
</table>
Currently, the monitor has limited built-in help in the GUI which will be expanded as its functions become more complex. Multilingual support is not implemented but can be internationalized with wxwidgets macros.

There is no integration with Workflow as this is handled by the P&P Engine for command and reporting. This may be needed when the monitor is able to manage as well as monitor active programmes. The P&P Engine is to support an ‘About’ for citing, Copyright etc. required for AXMEDIS projects and EC in a proper manner, as will be defined later. This however has not been implemented yet.

The P&P Engine Monitor uses the wxWidget 2.4 libraries with the wxWindows licence (see [http://www.wxwidgets.org/newlicen.htm](http://www.wxwidgets.org/newlicen.htm)) and the Xerces 2.6 libraries with the [Apache Software License, Version 2.0](http://www.apache.org/licenses/LICENSE-2.0.html), and the gSOAP v2.7.7 library with the choice of one of the following licenses: gSOAP license, GPL or a proprietary license.

### 5.2 Module Design in terms of Classes

![Class Diagram](image)

### 5.3 User interface description

#### Monitor

The Monitor provides a GUI to the P&P Engine. It is a separate process and can be run on a different machine to the P&P Engine.

When a user runs the P&P Engine Monitor, an application window appears with two panels: the left panel has a tree which lists all the active programmes, and the right panel displays the details of the selected programme. There is also a button on the right panel allowing users to “kill” a programme.

#### Menus

There are two menus. The **Action** menu includes:
- Refresh (re-connect to an engine)
- Disconnect
- Kill Programme

The **File** menu includes:
- Configuration: where users can specify the Engine address and the interval for sending update request.
5.4 Technical and Installation information

To run the P&P Engine Monitor the following files are currently required:
- axpnpengmonitor.exe
- axmedis_pnp_logo.bmp

In the release mode, no other libraries or components are required.

5.5 Draft User Manual

After starting, the Monitor will automatically try to connect to the Engine. The server address of the Engine can be configured by selecting the “File -> Configuration” menu. A dialog will pop up allowing the user to edit the Engine address (see the left figure below). Once a connection has been established the "Log” window will show that a connection has been made and requests have been sent to the Engine to get the updated list of active programmes (see the right figure below). The “Log” windows is also the place where all the activities (e.g. making connections, sending requests, failing, etc.) are presented. The user can hide/display the “Log” window using the menu “View -> Log Window”.

The user can disconnect or refresh the connection using the menu “Action -> Disconnect” and “Action -> Refresh” respectively.

If there are active programmes in the Engine, the Monitor will display them in the tree view. Clicking on a specific programme will show its details on the right panel. The tree view can also be hid/displayed using the menu “View -> Programmes Tree”.

The Monitor updates the information from the Engine at a fixed interval. That interval can be configured using the menu “File -> Configuration” and selecting the second item (PNP_ENG_MONITOR) in the dialog. The value is in second. This is illustrated in the figure below:
To delete an active programme from the engine the user must first select a programme, then click on the ‘Remove’ button. There is a small delay while the engine wakes up the programme and destroys it before the window is refreshed and the programme is removed.

5.6 Examples of usage
Run the executable from within your OS and connect to an engine (this defaults to localhost and can be set to a different hostname.

Once connected, the user is presented with a tree view of all the currently activated P&P Programmes currently running on the P&P Engine. On the right panel is the details of the selected programme.

5.7 Integration and compilation issues
The P&P Engine Monitor is self contained and is used to connect to the P&P Engine. Therefore there are no integration issues within the AXMEDIS Framework and the P&P Engine Monitor. Compilation requires the use of wxWidget. The preferences are set to find the wxWidget libraries and requires the environment variables to be set for wxWidget and Xerces. Control Panel -> System -> Advanced -> Environment Variable
- $(WXWIN) = where wxWindows-2.4.2 is installed
- $(XERCES) = where xerces-c_2_6_0 is installed
- $(GSOAP) = where gSOAP v2.7.7 is installed

5.8 Configuration Parameters

<table>
<thead>
<tr>
<th>Config parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNP_ENG_SERVER</td>
<td>Address: The address of the PnP Engine. The format of the address is name:port where name is the IP address or the host name, and port is the port that the PnP Engine listens to. The default address is localhost:3004</td>
</tr>
<tr>
<td>PNP_ENG_MONITOR</td>
<td>Update_Interval: The interval (in second) for the monitor to send requests to the PnP Engine to get updated information.</td>
</tr>
</tbody>
</table>
## 5.9 Errors reported and that may occur

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description and rationales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request failed</td>
<td>Cannot send requests to the PnP Engine. This may be due to the PnP Engine is not available or disconnected.</td>
</tr>
<tr>
<td>Bad pnp programme message format: content length too short</td>
<td>A P&amp;P Programme was received but was not the same length as the header stated it would be</td>
</tr>
</tbody>
</table>
## 6 Executable Tool Programme and Publication Editor

<table>
<thead>
<tr>
<th>Module/Tool Profile</th>
<th>Programme and Publication Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsible Name</td>
<td>Kia Ng, Royce Neagle and Minh Thang Dang</td>
</tr>
<tr>
<td>Responsible Partner</td>
<td>UNIVLEEDS</td>
</tr>
<tr>
<td>Status (proposed/approved)</td>
<td>proposed</td>
</tr>
<tr>
<td>Implemented/not implemented</td>
<td>Implemented</td>
</tr>
<tr>
<td>Status of the implementation</td>
<td>Version 1.0</td>
</tr>
<tr>
<td>Executable or Library/module (Support)</td>
<td>Executable and Library</td>
</tr>
<tr>
<td>Single Thread or Multithread</td>
<td>Multithread</td>
</tr>
<tr>
<td>Language of Development</td>
<td>C++</td>
</tr>
<tr>
<td>Platforms supported</td>
<td>Microsoft Windows XP (Tested)</td>
</tr>
</tbody>
</table>

### Reference to the AXFW location of the source code demonstrator

- Executable: [https://cvs.axmedis.org/repos/Application/pnpeditor/source](https://cvs.axmedis.org/repos/Application/pnpeditor/source)  
  [https://cvs.axmedis.org/repos/Application/pnpeditor/include](https://cvs.axmedis.org/repos/Application/pnpeditor/include)
  [https://cvs.axmedis.org/repos/Framework/pnpeditor/include](https://cvs.axmedis.org/repos/Framework/pnpeditor/include)

### Reference to the AXFW location of the demonstrator executable tool for internal download

- Debug: [https://cvs.axmedis.org/repos/Application/pnpeditor/bin/win32/axpnpeditor-debug.exe](https://cvs.axmedis.org/repos/Application/pnpeditor/bin/win32/axpnpeditor-debug.exe)

### ACTIVITIES WP4 and WP5/General on AXFW and Guidelines


### Test cases (present/absent)

- Present

### Test cases location

- TC10.1, TC10.2, TC10.3, TC10.5

### Usage of the AXMEDIS configuration manager (yes/no)

- Yes

### Usage of the AXMEDIS Error

- No
<table>
<thead>
<tr>
<th>Manager (yes/no)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Problems not solved</td>
<td></td>
</tr>
<tr>
<td>Major pending requirements</td>
<td></td>
</tr>
<tr>
<td>Interfaces API with other tools, named as</td>
<td>Name of the communicating tools</td>
</tr>
<tr>
<td>Query Support</td>
<td>AxSelectionEditor</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow Plugin</td>
</tr>
<tr>
<td>Formats Used</td>
<td>Shared with</td>
</tr>
<tr>
<td>XML plus schema</td>
<td>axpnprule.xsd</td>
</tr>
<tr>
<td>Protocol Used</td>
<td>Shared with</td>
</tr>
<tr>
<td>WebServices</td>
<td>AXMEDIS Workflow - Master</td>
</tr>
<tr>
<td>WebServices</td>
<td>AXMEDIS Workflow - Slave</td>
</tr>
<tr>
<td>Webservices</td>
<td>P&amp;P Engine</td>
</tr>
<tr>
<td>Used Database name</td>
<td>AXDB</td>
</tr>
<tr>
<td>User Interface</td>
<td>Development model, language, etc.</td>
</tr>
<tr>
<td>Visual Studio 7 .NET</td>
<td>AXMEDIS Plug-in Manager</td>
</tr>
<tr>
<td>C++</td>
<td>AXMEDIS Configuration Manager</td>
</tr>
<tr>
<td></td>
<td>AXMEDIS common</td>
</tr>
<tr>
<td></td>
<td>AXMEDIS pnpmodel</td>
</tr>
<tr>
<td></td>
<td>AXMEDIS AxSelection</td>
</tr>
<tr>
<td>Used Libraries</td>
<td>Name of the library and version</td>
</tr>
<tr>
<td>wxWidget</td>
<td>wxWindows version 2.4</td>
</tr>
<tr>
<td>gSOAP</td>
<td>gSOAP v.2.7.7</td>
</tr>
</tbody>
</table>
6.1 General Description of the Module

A Programme Manager can use a GUI to interact with the Query Support User Interface to make selections from the Query results in order to schedule some programmes (e.g. day, week, month, and year) with the following rules:

- **WHAT**: the AXMEDIS object of interest
- **WHERE**: destination channel, where to publish e.g. iTV or kiosk or other, and “where” profile
- **WHEN**: date, time, slot, duration
- **HOW**: direct transfer, reference or require formatting engine

The representation of the above rules could be represented using XML.

The Programme and Publication Programme Editor will provide the following functionality:

- **Create**: a Programme Manager uses a GUI to create some P&P Programmes using the Query Support User Interface to browse the AXMEDIS database, to select, to schedule, and to return with a list of relevant objects
- **Edit**: a Programme Manager make changes to the programme rules selected from a list in the GUI read from the P&P Programme Repository. Changes can also include using the Query Support User Interface to browse the AXMEDIS database to select and to return with a list of relevant objects
- **Save**: send the P&P Programme to a P&P for archiving (configured local file)
- **Test**: Test the P&P Programme through the P&P Engine
- **Activate**: send the P&P Programme to the P&P Engine

The Configuration is handled by the AXMEDIS Configuration Manager to set the configuration of the P&P Editor including the GUI related parameters, Workflow gateway parameters, P&P Engine connection address and AXMEDIS Plug-in parameters to access Workflow. The project is built and tested on Windows XP but uses only portable libraries and code so could easily be made cross platform (provided the code from other partners also supports this). Currently the wxWidget, Xerces and gSOAP libraries are being used.

- Xerces licence: [Apache Software Licence, Version 2.0](http://www.apache.org/licenses/LICENSE-2.0.html)
- wxWidgets licence: [http://www.wxwidgets.org/newlicen.htm](http://www.wxwidgets.org/newlicen.htm)
- gSOAP licence: Can be chosen from gSOAP public license ([http://www.cs.fsu.edu/~engelen/license.html](http://www.cs.fsu.edu/~engelen/license.html)), GPL ([http://www.cs.fsu.edu/~engelen/gpl.txt](http://www.cs.fsu.edu/~engelen/gpl.txt)), or proprietary software development license ([http://www.genivia.com/Products/gsoap/GeniviaGSoapLicense.pdf](http://www.genivia.com/Products/gsoap/GeniviaGSoapLicense.pdf))

There are no components that could be of use to other partners at this time. The P&P Editor was specifically designed as a front end for P&P Programme creation and editing and currently the P&P Editor has not been implemented with multilingual support for the GUI interface. However, the wxWindows macro has been used for future development to begin implementation for multilingual support.

Functionalities to be implemented and are currently included are the printing of P&P XML Programme Rule. Future releases will also have the P&P Editor connecting to HTML help documentation from the Help Menu. The ‘About’ for citing is currently implemented without the citing, copyright etc. information inserted for display.

The P&P editor is integrated with AXMEDSI Workflow. Workflow can request editing of a new P&P Programme to send a P&P Programme with the request for editing. Workflow can also request the activation of a programme through the P&P Editor. These requests when completed send a notification for completion back to the AXMEDIS Workflow completed the request loop.
6.2 Module Design in terms of Classes

- PnPModel
  - PnPProgrammeTreeData
  - PnPHeaderTreeData
  - PnPDistributionTreeData
  - PnPScheduleTreeData
  - PnPRepositoryListDlg
  - PnPFrame
  - PnPChildFrame
  - PnPScheduleTreeData
  - DnDFile
  - PnPSoapClient
  - PnPEngineClient
  - PnPQueryDlg
  - PnPTimeDlg
  - PnPTreeCtrl
  - PnPTreeData
6.3 User interface description

![Initial P&P Editor View](image1.png)

Figure: Initial P&P Editor View

![P&P Editor Displaying Programme Window and Workspace with Tree View](image2.png)

Figure: P&P Editor Displaying Programme Window and Workspace with Tree View
6.4 Technical and Installation information

- Installation capability, it has to be installable in a very easy manner
- Manual support for technical and user point of views

Installing the AXMEDIS Programme and Publication Editor is simply installing the executable axpnpeditor.exe into a directory and double clicking to run the application. The following libraries and file requirements are necessary to run the applications.

**Libraries Required**
- xerces-c_2_6.dll (Xerces - http://xml.apache.org/xerces-c/)

**Files Required**
- configuration.xsd
- axpnprule.xsd
- Selection-v1-6.xsd
- pnpeditor-configuration.xml (configuration file)
- plugin/rePlugin.dll (workflow rule editor Plug-in)
- plugin/rePlugin.xml (workflow rule editor Plug-in configuration file)

<table>
<thead>
<tr>
<th>References to other major components needed</th>
<th>Problems not solved</th>
</tr>
</thead>
<tbody>
<tr>
<td>P&amp;P Engine to upload a programme is needed to be running to activate and test a P&amp;P Programme.</td>
<td>Set the path for the Query Support User interface</td>
</tr>
<tr>
<td>Query Support User Interface must be running</td>
<td>Set the Path for the Plug-in Directory to load the Workflow Plug-in</td>
</tr>
<tr>
<td>AXMEDIS Workflow can be running if required</td>
<td>Set the gateway for the Workflow</td>
</tr>
<tr>
<td></td>
<td>Set the Engine and Port Address for the P&amp;P Engine</td>
</tr>
</tbody>
</table>

6.5 Draft User Manual

**Scenario a**: New P&P programme
1. The actor opens the GUI (either through WF or directly) and selects a new P&P Programme
2. The programme manager uses query support to add AXObjects and/or Selections to the P&P Programme
3. The programme manager edits P&P Programme
4. The programme manager saves the P&P Programme to the P&P Repository
Scenario b: Loading and editing existing P&P Programme:
1. The programme manager opens the GUI and loads a P&P Programme from the P&P Programme Repository
2. The programme manager uses query support to add AXObjects and/or Selections to edit the P&P Programme
3. The programme manager saves the rule to the P&P Repository

Scenario c: Activating or testing an existing P&P programme:
1. The programme manager opens the GUI and loads a P&P Programme from the P&P Programme Repository
2. The programme manager activates/full trials/quick trials the P&P Programme
3. The programme is sent to the P&P Engine using the Active P&P Programme Repository

Programme and Publication Programme Production
A programme producer or manager wishes to create a programme of multimedia objects for viewing on a selected distribution channel. This can be achieved by using the P&P Editor to create a distribution programme which when complete is activated.

By opening the P&P Editor the programme manager can create a programme to specify the time and destination channel of the objects to be distributed. Once a programme has been created, the programme manager can save it for re-editing at a future time or test the programme. Testing the programme enables the programme manager to check if there are going to be any problems in sending each object and allow the manager within the editor to make changes to successfully distribute a programme. On completion of a complete programme, the programme manager activates the programme and during the programme life cycle the objects will be distributed until the programme has completed or the programme is removed from being activated.

Creating a programme
To create a programme, the programme manager starts the P&P Editor and from the opening screen creates a new programme by selecting “New” from the tool bar or using the File menu (File → New) or using the keyboard short cut “Ctrl-N” (see Screenshot 1). On requesting a new programme, the dialog box pops up and the programme managers enters the name of the draft programme and selects “OK” (see Screenshot 2).

After the programme name has been OK’d, the new programme is ready for editing with the ‘tree view’ used as a workspace and the programme window for editing the programme details and making a programme schedule (see Screenshot 3).
Loading and existing programme
Instead of creating a new programme, the programme manager may wish to edit an existing draft programme. The programme manager may have saved it as a file somewhere or saved it in the P&P Repository. By selecting ‘open’ or ‘P&P Programme Repository’, as seen in screenshot 4 and 5, the programme manager can load an existing draft programme from the Repository or elsewhere on the system.

Editing a programme
The programme manager can use the editor to edit multiple programmes (as shown in screenshot 6), and edit programme data such as general, producer and content information; set the schedule for activating the programme; and set the specifications for delivering a multimedia object such as channel and terminal as well as distribution date and time, duration, channel if a different channel for a particular multimedia object is required, and terminal if a different terminal is required for a particular multimedia object.
Editing functionalities include being able to drag and drop information from one programme to another using the workspace tree area as shown in the tree view in Screenshot 7 and the popup box in Screenshot 8 or using drop down menus by right clicking within the tree area as shown in Screenshot 9.
Testing a completed programme
Now the programme manager has created and edited his programme and believes it is ready for distribution, the programme manager has two options: the first is to run a quick trial; this ensures the programme devised is valid without any of the processing taking place (see Screenshot 10). This means request are made to AXMEDIS tools to make sure tasks can be accomplished for processing the programme. A message is return to the P&P Editor informing the user if the trial was successful or not. The second option is to run a full trial which enforces the P&P engine to request all the processing to be run if required with the exception of the final distribution to the distribution area. The processing jobs are requested and executed and on completion the results are returned. The final action of distribution is the only processing not requested in the full trial.

Activating and stopping a programme
When the programme manager is happy with his programme and validated it with a quick and/or full trial, the final option is to activate the programme. This sends the programme to the P&P Engine which processes the programme information and at the specified times distributes the correctly adapted multimedia object to the specified channel. During the lifespan of the active programme, the programme manager can also stop the
programme from the P&P Editor by selecting “Stop Programme” in the Command menu. This can be seen in Screenshot 10.

**Behind the scenes**
On programme activation, selected objects to be sent to a particular channel will be checked to see if the channel can use the object. If the object is fine, then nothing is done and the object is ready to be sent via the specified distribution channel. However, if there is a mismatch, the AXMEDIS tools in the AXMEDIS Factory are used to resize or format the object so that it can be distributed – providing the rights allow the object to be adapted of course. With the object (new or reformatted) that can now be sent, the P&P Engine uses an internal clock to distribute the object at the correct time, as specified in the programme by the programme manager.

**Conclusion**
Using the P&P Editor, the programme manager can setup a programme that sends objects through a selected distribution channel. The programme manager can create a programme and edit it to set when and where the objects are to be delivered and also test the programme to check that everything is valid for distribution. Once checked, the activated programme is sent to the P&P Engine which uses AXMEDIS tools to automatically adapt the objects to be valid for the distribution channel and at the specified time sends the correctly adapted object to the distribution servers.

**Learning Outcomes**
At the end of this tutorial session, the programme managers will understand:
- How the P&P Area fits within the AXMEDIS architecture
- How to use the P&P Editor to create a P&P programme to distribute objects on selected channels.
- A programme manager will be able to make a programme and edit existing programme schedules;
- Test a programme
- Activate the programme to deliver objects.
- Stop a programme that has been activated through the P&P Editor.

**6.6 Examples of usage**
Double click on axpnpeditor.exe to run the P&P Editor application.
Set the configuration file if necessary (Menu File->Configuration...) to specify the parameters for Workflow Plug-in and the P&P Engine address.

**6.7 Integration and compilation issues**

**How to get the source and place in the correct directories**
The recommended way of getting the P&P Model Source is to obtain it directly from the AXMEDIS CVS repository <URL:https://cvs.axmedis.org/repos/>. The directory structure is important for compilation with the .NET project file. The recommended method is to checkout the Framework directory. The required header files, source files, libraries, .NET project file and required dll's to use the P&P Model are located within the repository as shown below.

```
Framework
|- include
  |- pnpeditor
    |- *.h
    |- pnpsoapengineclient
      |- *.h
      |- *.xsd
      |- *.wsdl
|- project
  |- pnpeditor
    |- win32
      |- axpnpeditorlib.vcproj
```
Other requirements

The P&P Editor GUI requires wxWidget 2.4.2 and depends on the P&P Model and P&P Editor libraries. To download and install wxWidget, please refer to the AXMEDIS documentation or the following website

- wxWidget C - http://www.wxwindows.org/
- xerces-c_2_6_0 - http://xml.apache.org/xerces-c/
- gSOAP v2.7.7 - http://gsoap2.sourceforge.net/

The P&P Model libraries (axpnpmodel.lib and axpnpmodel_d.lib) and the P&P Editor (axpnpeditor.lib and axpnpeditor_d.lib) libraries and the respective include header files can be located in the CVS as shown in the following diagram.

Framework

```
|- include
  |- pnpeditor
    |- *.h
  |- pnpmodel
    |- *.h
|- bin
  |- pnpmodel
  |- win32
    |- pnpmodel
  |- win32
```

To build the libraries from source, see HowToBuild.txt in the CVS Framework

Framework

```
|- project
  |- pnpmodel
    |- win32
      |- HowToBuild.txt
  |- pnpeditor
    |- win32
      |- HowToBuild.txt
```

Building the Source using Microsoft Visual C++

The .NET preferences are set to find the files in the directory structure as shown in part 1 and requires the environment variables to be set for wxWidget and Xerces. Control Panel -> System -> Advanced -> Environment Variable

- $WXWIN = where wxWindows-2.4.2 is installed
- $LIBCURL = where libcurl-devel-7.15.1 is installed
• $(MOZILLA) = where wxMozilla:mozilla is installed
• $(WSDL_PULL) = where wsdlpull-1.9 is installed
• $(XERCES) = where xerces-c_2_6_0 is installed
• $(GSOAP) = where gSOAP v2.7.7 is installed

NB if you are building Xerces from source you will have to set XERCESCROOT to where you have installed the source code for Xerces. Building the libraries can be done as a batch build or build individually in the build menu for the Debug and Release libraries.

Running the P&P Editor application
To run the application the following files need to be installed in the same directory:
• Xerces dll's depending on whether the last compilation was Debug or Release
  xerces-c_2_6.dll
  xerces-c_2_6D.dll
• schemas (required to validate the P&P XML files (.pp))
  axpnrule.xsd
  Selection-v1-6.xsd

6.8 Configuration Parameters

<table>
<thead>
<tr>
<th>Config parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXMEDIS_PLUGIN_MANAGER</td>
<td>&lt;path-to-executable&gt;/plugin</td>
</tr>
<tr>
<td>AXMEDIS_SELECTION</td>
<td>http://&lt;address_to_database_query_wsd</td>
</tr>
<tr>
<td>AXMEDIS_PNP_ENGINE</td>
<td>localhost:3000</td>
</tr>
<tr>
<td>WORKFLOW</td>
<td>http://&lt;workflow-address&gt;:8080/OpenFlow/index.html</td>
</tr>
<tr>
<td>PNP_REPOSITORY</td>
<td>&lt;path-to-pnp-repository&gt;</td>
</tr>
<tr>
<td>AXCP_RULES</td>
<td>&lt;display name&gt;</td>
</tr>
<tr>
<td>AXMEDIS_PNP_EDITOR</td>
<td>&lt;path-to-pnp-schemas-and-xml-configuration-files&gt;</td>
</tr>
<tr>
<td>AXMEDIS_PNP_DISTRIBUTORS</td>
<td>&lt;distribution-name-in-PnP-Engine&gt;</td>
</tr>
</tbody>
</table>

6.9 Errors reported and that may occur

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description and rationales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Error: Unable to connect to P&amp;P Engine</td>
<td>Called when P&amp;P Programme is activated and the connection to the P&amp;P Engine has failed</td>
</tr>
<tr>
<td>Report: Workflow is currently not present</td>
<td>Called when P&amp;P Editor is run independent of Workflow</td>
</tr>
<tr>
<td>Connection Error: WSDL</td>
<td></td>
</tr>
</tbody>
</table>

AXMEDIS Project
## 7 Module Tool Programme and Publication Rule Model

<table>
<thead>
<tr>
<th>Module/Tool Profile</th>
<th>Programme and Publication Rule Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsible Name</td>
<td>Kia Ng, Royce Neagle and Minh Thang Dang</td>
</tr>
<tr>
<td>Responsible Partner</td>
<td>UNIVLEEDS</td>
</tr>
<tr>
<td>Status (proposed/approved)</td>
<td>Proposed</td>
</tr>
<tr>
<td>Implemented/not implemented</td>
<td>Implemented</td>
</tr>
<tr>
<td>Status of the implementation</td>
<td>Version 1.0</td>
</tr>
<tr>
<td>Executable or Library/module (Support)</td>
<td>Library</td>
</tr>
<tr>
<td>Single Thread or Multithread</td>
<td>Multithread</td>
</tr>
<tr>
<td>Language of Development</td>
<td>C++</td>
</tr>
<tr>
<td>Platforms supported</td>
<td>Microsoft Windows XP (Tested)</td>
</tr>
<tr>
<td>Reference to the AXFW location of the source code demonstrator</td>
<td><a href="https://cvs.axmedis.org/repos/Framework/pnpmodel/source">https://cvs.axmedis.org/repos/Framework/pnpmodel/source</a></td>
</tr>
<tr>
<td>Reference to the AXFW location of the demonstrator executable tool for internal download</td>
<td>Debug: <a href="https://cvs.axmedis.org/repos/Framework/pnpmodel/bin/win32/axpnpmodel_d.lib">https://cvs.axmedis.org/repos/Framework/pnpmodel/bin/win32/axpnpmodel_d.lib</a></td>
</tr>
<tr>
<td>Reference to the AXFW location of the demonstrator executable tool for public download</td>
<td>Release: <a href="https://cvs.axmedis.org/repos/Framework/pnpmodel/bin/win32/axpnpmodel.lib">https://cvs.axmedis.org/repos/Framework/pnpmodel/bin/win32/axpnpmodel.lib</a></td>
</tr>
<tr>
<td>Address for accessing to WebServices if any, add accession information (user and Passwd ) if any</td>
<td></td>
</tr>
<tr>
<td>Test cases (present/absent)</td>
<td>present</td>
</tr>
<tr>
<td>Usage of the AXMEDIS configuration manager (yes/no)</td>
<td>No</td>
</tr>
<tr>
<td>Usage of the AXMEDIS Error Manager (yes/no)</td>
<td>No</td>
</tr>
<tr>
<td>Major Problems not solved</td>
<td>--</td>
</tr>
<tr>
<td>Major pending requirements</td>
<td></td>
</tr>
<tr>
<td>Interfaces API with other tools, named as</td>
<td>Name of the communicating tools</td>
</tr>
<tr>
<td>References to other major components needed</td>
<td>Communication model and format (protected or not, etc.)</td>
</tr>
</tbody>
</table>
### Formats Used

<table>
<thead>
<tr>
<th>Format</th>
<th>Shared with</th>
<th>format name or reference to a section</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML plus schema</td>
<td>P&amp;P Engine Executable</td>
<td>Programme and Publication Format with extension .pp</td>
</tr>
<tr>
<td>• axpnpnrule.xsd</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Protocol Used

<table>
<thead>
<tr>
<th>Protocol Used</th>
<th>Shared with</th>
<th>Protocol name or reference to a section</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Used Database name

<table>
<thead>
<tr>
<th>Used Database name</th>
<th>Development model, language, etc.</th>
<th>Library used for the development, platform, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### User Interface

<table>
<thead>
<tr>
<th>User Interface</th>
<th>Name of the library and version</th>
<th>License status: GPL, LGPL, PEK, proprietary, authorized or not</th>
</tr>
</thead>
<tbody>
<tr>
<td>C++</td>
<td>AXMEDIS common</td>
<td>AXMEDIS pnpmodel</td>
</tr>
<tr>
<td>AXMEDIS Configuration Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AXMEDIS common</td>
<td>AXMEDIS pnpmodel</td>
<td></td>
</tr>
</tbody>
</table>

### Used Libraries

<table>
<thead>
<tr>
<th>Used Libraries</th>
<th>Name of the library and version</th>
<th>License status: GPL, LGPL, PEK, proprietary, authorized or not</th>
</tr>
</thead>
<tbody>
<tr>
<td>wxWidget</td>
<td>wxWindows version 2.4</td>
<td>wxWindows licence (<a href="http://www.wxwidgets.org/newlicen.htm">http://www.wxwidgets.org/newlicen.htm</a>)</td>
</tr>
<tr>
<td>gSOAP</td>
<td>gSOAP v2.7.7</td>
<td>Can be chosen from gSOAP public license (<a href="http://www.cs.fsu.edu/~engelen/license.html">http://www.cs.fsu.edu/~engelen/license.html</a>), GPL (<a href="http://www.cs.fsu.edu/~engelen/gpl.txt">http://www.cs.fsu.edu/~engelen/gpl.txt</a>), or proprietary software development license (<a href="http://www.genivia.com/Products/gsoap/GeniviaGSoapLicense.pdf">http://www.genivia.com/Products/gsoap/GeniviaGSoapLicense.pdf</a>)</td>
</tr>
</tbody>
</table>

7.1 General Description of the Module

The P&P Rule Model provides the methods to manipulate the P&P Programme data. The data is separated into three sections. These sections are: the header (AxRuleHeader); the schedule (AxRuleSchedule); and the Arguments comprising of the AxPnPRule and AxRuleDistribution data.

**P&P Programme Header (AxRuleHeader)**

This section holds the following data:

- P&P Programme Name (type: String) specifies the name of the programme
- P&P Programme ID (type: String) this is a unique value of 40 bytes with the first four bytes ("pnp_")
- P&P Programme Version (type: String) specifying which P&P Programme Rule version is used to create a P&P Programme
- P&P Rule (type: String) is always defined as AxPnP
- Software Name (type: String) storing the name of the software used to create the P&P Programme e.g. P&P Editor
- Software Version (type: String) storing the version of the software used to create the P&P Programme
- Production date when the P&P Programme was first created
- Author (type: String), Affiliation (type: String) and URL (type: String) to specify metadata information on the author of the P&P Programme
• Last Modification specifying the last time the P&P Programme was edited and saved
• Terminal ID (type: String) specifying the user’s terminal the programme was last edited on.
• Cost (type: String). This is a redundant field used by the AXCP Rule.
• Work Item ID (type: String) is the field specifying the Workflow Job Request for a Programme. This includes request for a new P&P Programme, editing an existing Programme, and activating a P&P Programme. This is used when sending a notification of completion back to workflow
• Comment (type: String) is the field where the author of the P&P Programme can add comments.

P&P Programme Schedule (AxRuleSchedule)
• Firing Date is the start date for the P&P Programme to be activated by the P&P Engine
• Firing Time is the start time for the P&P Programme to be activated by the P&P Engine
• Expiration Date is the end date for the P&P Programme to be killed by the P&P Engine
• Expiration Time is the end time for the P&P Programme to be killed by the P&P Engine
• Periodicity includes the period (type: String) and units when a programme needs to repeat itself and how often
• Status (type: String) specifies the current status of the P&P Programme i.e. active, inactive, quick trial or full trial

P&P Programme Arguments (AxPnPRule)
• Distribution List (P&P Programme Distribution) is a list of AXMEDIS objects to be distributed including information such as when, where, and how
• Global Distribution Channel ID (type: String) is the distribution channel to be used by the P&P Programme
• Global Distribution Terminal ID (type: String) is the distribution terminal to be used by the P&P Programme
• Global Content Processing ID (type: String)
• Programme Type (type: String) is an enumerated list including OnDemand, Object and Programme.

P&P Programme Distribution (AxRuleDistribution)
• Start Date (type: Date) is the start date for the distribution of the AXMEDIS Object
• Start Time (type: Time) is the start time for the distribution of the AXMEDIS Object
• End Date (type: Date) is the end date for the distribution of the AXMEDIS Object
• End Time (type: Time) is the end time for the distribution of the AXMEDIS Object
• Distribution Channel ID is the channel the object is to be distributed if different from the global distribution specified in the section above
• Distribution Terminal ID (type: String) is the terminal the object is to be distributed if different from the global distribution specified in the section above
• Content Processing Rule (type: String) is the name and values of the parameters to pass into the AXCP Rule.
• Content Processing Parameters (type: String) are the parameters to be used with the previous Content Processing Rule
• Selection is an AXMEDIS Object or group of AXMEDIS Objects to be distributed
• AXOID is a single AXMEDIS Object to be distributed
• Description (type: String) is the field where the author of the P&P Programme can add a description for each object to be distributed. If nothing is added, this file will have the Dublin Core name added. See the comment field in the Header section for adding comments concerning a P&P Programme.
7.2 Module Design in terms of Classes

7.3 User interface description
This is a library module that can be used by all partners for creating, editing and saving P&P Programmes. There is no user interface.

7.4 Technical and Installation information

| References to other major components needed | - P&P Engine to upload a programme is needed to be running to activate and test a P&P Programme.  
|                                              | - Query Support User Interface must be running  
|                                              | - AXMEDIS Workflow can be running |

| Problems not solved                          | - Set the path for the Query Support User interface  
|                                              | - Set the Path for the Plug-in Directory to load the Workflow Plug-in  
|                                              | - Set the Engine and Port Address for the P&P Engine |

| Configuration and execution context         | - PnP Editor  
|                                            | - 1.0  
|                                            | 2006-03-15  
|                                            | -  
|                                            | -  
|                                            | -  

7.5 Examples of usage

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Rule xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation="axpnprule.xsd">
  <Header>
    <Rule_Name>New Programme</Rule_Name>
    <AXRID>pnp_84746afdf-e022-4f5a-b834-6d9af8e41e7</AXRID>
    <Rule_Version>1.0</Rule_Version>
    <Rule_Type>AXPnP</Rule_Type>
    <Software_Name>PnP Editor</Software_Name>
    <Version_of_software>1.0</Version_of_software>
    <Date_of_production>2006-03-15</Date_of_production>
    <Author></Author>
    <Affiliation></Affiliation>
    <URL></URL>
    <Comment></Comment>
    <Last_Modifications>2006-03-15</Last_Modifications>
    <Terminal_ID></Terminal_ID>
    <Cost></Cost>
    <Work_Item_ID></Work_Item_ID>
  </Header>
  <Schedule>
```

AXMEDIS Project
7.6 Integration and compilation issues

How to get the source and place in the correct directories

The recommended way of getting the P&P Model source is to obtain it directly from the AXMEDIS CVS repository <URL:https://cvs.axmedis.org/repos/>. The directory structure is important for compilation with the .NET project file. The recommended method is to checkout the Framework directory. The required header files, source files, libraries, .NET project file and required dll's to use the P&P Model are located within the repository as shown below.

```
Framework
|-- include
|   |-- model
|       |--*.h
|-- project
|   |--pnpmodel
|       |--win32
|           |--axpnpmodel.vcproj
|           |--HowToBuild.txt
|-- bin
|   |--pnpmodel
|       |--win32
|           |--axpnpmodel.lib (Release)
|          |--axpnpmodel_d.lib (Debug)
|-- source
|   |--pnpmodel
|       |--*.cpp
```
Other requirements
The P&P Model requires wxWidget 2.4.2 and Xerces 2.6. To download and install please refer to the AXMEDIS documentation or the following websites
- wxWidget C - http://www.wxwindows.org/
- Xerces C++ - http://xml.apache.org/xerces-c/

Building the Source using Microsoft Visual C++
The preferences are set to find the files in the directory structure as shown in part 1 and requires the environment variables to be set for wxWidget and Xerces. Control Panel → System → Advanced → Environment Variable
- $(WXWIN) = where wxWindows-2.4.2 is installed
- $(XERCES) = where Xerces is installed
- $(GSOAP) = where gSOAP is installed

NB if you are building Xerces from source you will have to set XERCESCROOT to where you have installed the source code for Xerces.

Building the libraries can be done as a batch build or build individually in the build menu for the Debug and Release libraries.

7.7 Errors reported and that may occur

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description and rationales</th>
</tr>
</thead>
<tbody>
<tr>
<td>warning</td>
<td>SAX Error handler specifying warning messages during the parsing of the P&amp;P Programme from file or XML string. The XML P&amp;P Programme is still parsed.</td>
</tr>
<tr>
<td>Error</td>
<td>SAX Error handler specifying error messages during the parsing of the P&amp;P Programme from file or XML string.</td>
</tr>
<tr>
<td>fatalError</td>
<td>SAX Error handler specifying fatal error messages during the parsing of the P&amp;P Programme from file or XML string.</td>
</tr>
</tbody>
</table>

7.8 Formal description of algorithm to sort the P&P Programme Distribution List

<table>
<thead>
<tr>
<th>P&amp;P Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Input parameters</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Output parameters</td>
</tr>
</tbody>
</table>

This method utilises the wxWindows sort function for the wxList class and a P&P Distribution list compare function returning -1, 0 or 1 is implemented for the P&P programme distribution fields returning
### 7.9 Formal description of algorithm to add a Distribution Rule to the P&P Programme

<table>
<thead>
<tr>
<th>P&amp;P Model</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method</strong></td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Input parameters</strong></td>
</tr>
<tr>
<td><strong>Output parameters</strong></td>
</tr>
</tbody>
</table>

To utilise this method, the method requires a new distribution to be created. The pseudo code is:

1. Create new distribution rule
2. Add rules
3. Append distribution to the P&P Programme

```
AxRuleDistribution* newDistribution = new AxRuleDistribution();
newDistribution->setStartDate((wxDateTime)date_to_start_distribution);
newDistribution->setStartTime((wxDateTime)time_to_start_distribution);
...
pnpProgramme->appendDistribution(newDistribution);
```
8 Formal description of format P&P Programme
8.1 P&P Programme XML Schema

The following XML schema refers to the axpnprule.xsd

element Rule

diagram

children

Header Schedule Definition

source

<?xml version="1.0" encoding="UTF-8"?>
<!-- edited with XMLSPY v2004 rel. 3 U (http://www.xmlspy.com) by UNIVLEEDS -->
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified"
attributeFormDefault="unqualified">
<xs:include schemaLocation="Selection-v1-6.xsd"/>
<xs:simpleType name="periodunit">
<xs:restriction base="xs:string">
<xs:enumeration value="Day"/>
<xs:enumeration value="Month"/>
<xs:enumeration value="Week"/>
<xs:enumeration value="Year"/>
</xs:restriction>
</xs:simpleType>
<xs:element name="Rule">
<xs:complexType>
<xs:sequence>
<xs:element name="Header">
<xs:complexType>
<xs:sequence>
<xs:element name="Rule_Name" type="xs:string"/>
<xs:element name="AXRID" type="xs:string"/>
<xs:element name="Rule_Version" type="xs:string"/>
<xs:element name="Rule_Type">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="AXCP"/>
<xs:enumeration value="AXPnP"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="Schedule">
<xs:complexType>
<xs:sequence>
<xs:element name="Run"/>
<xs:complexType>
  <xs:sequence>
    <xs:element name="Date" type="xs:date"/>
    <xs:element name="Time" type="xs:time"/>
    <xs:element name="Periodicity" minOccurs="0">
      <xs:complexType>
        <xs:simpleContent>
          <xs:extension base="xs:integer">
            <xs:attribute name="Unit" type="periodunit"/>
          </xs:extension>
        </xs:simpleContent>
      </xs:element>
    </xs:element>
    <xs:element name="Expiration_Date" type="xs:date" minOccurs="0"/>
    <xs:element name="Expiration_Time" type="xs:time" minOccurs="0"/>
  </xs:sequence>
</xs:complexType>
<xs:element name="Status">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:enumeration value="Active"/>
      <xs:enumeration value="QTrial"/>
      <xs:enumeration value="FTrial"/>
      <xs:enumeration value="Inactive"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>
<xs:element name="Definition">
  <xs:complexType>
    <xs:choice minOccurs="0">
      <xs:element name="PnP_Rule">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="Distribution">
              <xs:complexType>
                <xs:sequence>
                  <xs:element name="DistributionChannelID" type="xs:string"/>
                  <xs:element name="DistributionTerminalID" type="xs:string" minOccurs="0"/>
                  <xs:element name="GlobalAxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
                  <xs:element name="Programme_Type" minOccurs="0">
                    <xs:simpleType>
                      <xs:restriction base="xs:string">
                        <xs:enumeration value="OnDemand"/>
                        <xs:enumeration value="Object"/>
                        <xs:enumeration value="Programme"/>
                      </xs:restriction>
                    </xs:simpleType>
                  </xs:element>
                </xs:sequence>
              </xs:complexType>
            </xs:element>
            <xs:element name="Arguments" minOccurs="0" maxOccurs="unbounded">
              <xs:complexType>
                <xs:simpleContent>
                  <xs:extension base="xs:string">
                    <xs:attribute name="ParameterName" type="xs:string" use="required"/>
                  </xs:extension>
                </xs:simpleContent>
              </xs:complexType>
            </xs:element>
            <xs:element name="Description" type="xs:string" minOccurs="0"/>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
    </xs:choice>
  </xs:complexType>
</xs:element>

AXMEDIS Project

52
element Rule/Header

diagram

children

Rule_Name  AXRID  Rule_Version  Rule_Type  Software_Name  Version_of_software  Date_of_production
Author  Affiliation  URL  Comment  Last_Modifications  Terminal_ID  Cost  Work_Item_ID

source

<x:schema>
  <xs:element name="Rule_Header">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="Rule_Name" type="xs:string"/>
        <xs:element name="AXRID" type="xs:string"/>
        <xs:element name="Rule_Version" type="xs:string"/>
        <xs:element name="Rule_Type" type="xs:string">"AXCP"</xs:element>
        <xs:element name="Software_Name" type="xs:string"/>
        <xs:element name="Version_of_software" type="xs:string"/>
        <xs:element name="Date_of_production" type="xs:string"/>
        <xs:element name="Author" type="xs:string"/>
        <xs:element name="Affiliation" type="xs:string"/>
        <xs:element name="URL" type="xs:string"/>
        <xs:element name="Comment" type="xs:string"/>
        <xs:element name="Last_Modifications" type="xs:string"/>
        <xs:element name="Terminal_ID" type="xs:string"/>
        <xs:element name="Cost" type="xs:string"/>
        <xs:element name="Work_Item_ID" type="xs:string"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
description This section contains metadata related to general information associated with a rule

element Rule/Header/Rule_Name
diagram

type xs:string
source <xs:element name="Rule_Name" type="xs:string"/>
description It defines the name of the rule, e.g. “Audio Collection”

element Rule/Header/AXRID
diagram

type xs:string
source <xs:element name="AXRID" type="xs:string"/>
description It defines the AXMEDIS Rule ID

element Rule/Header/Rule_Version
diagram

type xs:string
source <xs:element name="Rule_Version" type="xs:string"/>
description It defines the version of the rule, e.g. “1.0”

element Rule/Header/Rule_Type
diagram

type restriction of xs:string
facets enumeration AXCP
enumeration AXPnP
source <xs:element name="Rule_Type">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:enumeration value="AXCP"/>
      <xs:enumeration value="AXnPnP"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>
description It defines the type of rule, AXCP rules identifies all rules related to the Content Processing Area, whereas the AXPnP
rules are the rule of the P&P area

element Rule/Header/Software_Name
diagram

type xs:string
source <xs:element name="Software_Name" type="xs:string"/>
description It specifies the name of software used, e.g. "AXMEDIS Rule Editor"

element Rule/Header/Version_of_software
diagram

type xs:string
source <xs:element name="Version_of_software" type="xs:string"/>
description It defines the version of software used., e.g. "2.0"

element Rule/Header/Date_of_production
diagram

type xs:date
source <xs:element name="Date_of_production" type="xs:date"/>
description It defines when the rule has been created
Note This item now embeds the item Time_of_Production defined in the DE3-1-2C-AXFW_Spec-(content-production)-Part-C document.

: element Rule/Header/Author
diagram

type xs:string
source <xs:element name="Author" type="xs:string"/>
description It defines the name of author who has created the rule

element Rule/Header/Affiliation
diagram

type xs:string
source <xs:element name="Affiliation" type="xs:string"/>
description It defines the name of Affiliation

element Rule/Header/URL
DE3.1.2.3.11 – Specification of AXMEDIS Programme and Publication Tools

**type** xs:anyURI
**source** `<xs:element name="URL" type="xs:anyURI"/>`
**description** It defines the Internet address/URL of the Affiliation

**element Rule/Header/Comment**
**diagram**
```
Comment
```

**type** xs:string
**source** `<xs:element name="Comment" type="xs:string"/>`
**description** Of the P&P Programme

**element Rule/Header/Last_Modifications**
**diagram**
```
Last_Modifications
```

**type** xs:date
**source** `<xs:element name="Last_Modifications" type="xs:date"/>`
**description** It is used to report the last modified date

**element Rule/Header/Cost**
**diagram**
```
Cost
```

**type** xs:string
**source** `<xs:element name="Cost" type="xs:string"/>`
**description** Estimation of Cost

**element Rule/Header/Work_Item_ID**
**diagram**
```
Work_Item_ID
```

**type** xs:string
**source** `<xs:element name="Work_Item_ID" type="xs:string"/>`
**description** External reference, for instance the commitment

**element Rule/Schedule**
**diagram**
```
Schedule -> Run
Schedule -> Status
```

**children** Run Status
**source** `<xs:element name="Schedule">`  
`<xs:complexType>`  
`<xs:sequence>`  
`<xs:element name="Run">`  
`<xs:complexType>`  
`<xs:sequence>`  
`<xs:element name="Date" type="xs:date"/>`  
`<xs:element name="Time" type="xs:time"/>`
This section contains the sequence of metadata for programming the activation of a programme.

**element Rule/Schedule/Run**

**source**

```
<xs:element name="Run">
  <xs:complexType>
    <xs:sequence>
      <xs:element name="Date" type="xs:date" minOccurs="0"/>
      <xs:element name="Time" type="xs:time" minOccurs="0"/>
      <xs:element name="Periodicity" minOccurs="0">
        <xs:complexType>
          <xs:simpleContent>
            <xs:extension base="xs:integer">
              <xs:attribute name="Unit" type="periodunit"/>
            </xs:extension>
          </xs:simpleContent>
        </xs:complexType>
      </xs:element>
      <xs:element name="Expiration_Date" type="xs:date" minOccurs="0"/>
      <xs:element name="Expiration_Time" type="xs:time" minOccurs="0"/>
    </xs:sequence>
  </xs:complexType>
</xs:element>
```

**description**

It defines a subsection of metadata that describes information needed for scheduling the execution of the rule.
element Rule/Schedule/Run/Date
diagram

type xs:date
source `<xs:element name="Date" type="xs:date"/>
description It defines when the rule has to be executed by the engine in terms of day, month and year.

element Rule/Schedule/Run/Time
diagram

type xs:time
source `<xs:element name="Time" type="xs:time"/>
description It defines when the rule has to be executed by the engine in term of time clock.

element Rule/Schedule/Run/Periodicity
diagram

type extension of xs:integer
attributes
  Name     Type       Use     Default   Fixed   Annotation
  Unit     periodunit
source `<xs:element name="Periodicity" minOccurs="0">
  <xs:complexType>
    <xs:simpleContent>
      <xs:extension base="xs:integer">
        <xs:attribute name="Unit" type="periodunit"/>
      </xs:extension>
    </xs:simpleContent>
  </xs:complexType>
</xs:element>
description It defines if a rule has to be executed periodically, every "Unit" "periodunit" e.g. "2" "Week"

element Rule/Schedule/Run/Expiration_Date
diagram

type xs:date
source `<xs:element name="Expiration_Date" type="xs:date" minOccurs="0"/>
description The date to stop the periodicity

element Rule/Schedule/Run/Expiration_Time
diagram

type xs:time
source `<xs:element name="Expiration_Time" type="xs:time" minOccurs="0"/>
description The time to stop the periodicity
element Rule/Schedule/Status
diagram

<table>
<thead>
<tr>
<th>type</th>
<th>restriction of xs:string</th>
</tr>
</thead>
<tbody>
<tr>
<td>facets</td>
<td>enumeration Active</td>
</tr>
<tr>
<td></td>
<td>enumeration QTrial</td>
</tr>
<tr>
<td></td>
<td>enumeration FTrial</td>
</tr>
<tr>
<td></td>
<td>enumeration Inactive</td>
</tr>
</tbody>
</table>

source

```xml
<xs:element name="Status">
  <xs:simpleType>
    <xs:restriction base="xs:string">
      <xs:enumeration value="Active"/>
      <xs:enumeration value="QTrial"/>
      <xs:enumeration value="FTrial"/>
      <xs:enumeration value="Inactive"/>
    </xs:restriction>
  </xs:simpleType>
</xs:element>
```

description
It defines if a rule is:
• "active" and can be executed
• "quick trial" not to be executed but to ascertain that the programme can be run at execution time
• "full trial" is to executed all parts of the programme with the exception of distribution
• "inactive"

element Rule/Definition
diagram

children

| AXCP_Rule PnP_Rule |

source

```xml
<xs:element name="Definition">
  <xs:complexType>
    <xs:choice minOccurs="0">
      <xs:element name="PnP_Rule">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="Distribution">
              <xs:complexType>
                <xs:sequence>
                  <xs:element name="DistributionChannelID" type="xs:string"/>
                  <xs:element name="DistributionTerminalID" type="xs:string" minOccurs="0"/>
                  <xs:element name="GlobalAxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
                </xs:sequence>
              </xs:complexType>
            </xs:element>
            <xs:element name="Arguments" minOccurs="0" maxOccurs="unbounded">
              <xs:complexType>
                <xs:sequence>
                  <xs:element name="Start_Date" type="xs:date"/>
                  <xs:element name="Start_Time" type="xs:time"/>
                </xs:sequence>
              </xs:complexType>
            </xs:element>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
      <xs:element name="AXCP_Rule">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="AxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
    </xs:choice>
  </xs:complexType>
</xs:element>
```
DE3.1.2.3.11 – Specification of AXMEDIS Programme and Publication Tools

**element Rule/Definition/PnP_Rule**

**description** This section includes the section containing the procedural description of an AXCP or a PnP rule

**diagram**

```
  PnP_Rule -- Distribution |
             \               |
             \            \-- Arguments
```

**children** Distribution Arguments

**source**

```xml
<xs:element name="PnP_Rule">
  <xs:complexType>
    <xs:sequence>
      <xs:element name="Distribution">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="DistributionChannelID" type="xs:string"/>
            <xs:element name="DistributionTerminalID" type="xs:string" minOccurs="0"/>
            <xs:element name="GlobalAxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
            <xs:element name="Programme_Type" minOccurs="0">
              <xs:simpleType>
                <xs:restriction base="xs:string">
                  <xs:enumeration value="OnDemand"/>
                  <xs:enumeration value="Object"/>  
                  <xs:enumeration value="Programme"/>
                </xs:restriction>
              </xs:simpleType>
            </xs:element>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
      <xs:element name="Arguments" minOccurs="0" maxOccurs="unbounded">
        <xs:complexType>
          <xs:sequence>
            <xs:element name="Start_Date" type="xs:date"/>
            <xs:element name="Start_Time" type="xs:time"/>
            <xs:element name="End_Date" type="xs:date"/>
            <xs:element name="End_Time" type="xs:time"/>
            <xs:element name="ChannelID" type="xs:string" minOccurs="0"/>
            <xs:element name="TerminalID" type="xs:string" minOccurs="0"/>
            <xs:element name="AxContentProcessingParam" minOccurs="0" maxOccurs="unbounded">
              <xs:complexType>
                <xs:sequence>
                  <xs:element name="Start_Date" type="xs:date"/>
                </xs:sequence>
                <xs:element name="ParameterName" type="xs:string" use="required"/>
              </xs:complexType>
            </xs:element>
          </xs:sequence>
        </xs:complexType>
      </xs:element>
    </xs:sequence>
  </xs:complexType>
</xs:element>
```
element Rule/Definition/PnP_Rule/Distribution

description This section includes the section containing the distribution channel identifiers for the PnP Rule

diagram

```
DistributionChannelID  -----  DistributionTerminalID
                     ^
```

children DistributionChannelID DistributionTerminalID

source `<xs:element name="Distribution"/>

description This section includes the section containing the distribution channel identifier string

element Rule/Definition/PnP_Rule/Distribution

description This section includes the section containing the distribution terminal identifier address for the PnP Rule. This is most likely to be an IP Address

diagram

```
DistributionTerminalID
```

type Xs:String

source `<xs:element name="DistributionTerminalID" type="xs:string" minOccurs="0"/>

element Rule/Definition/PnP_Rule/Distribution

description This section includes the section containing the distribution terminal identifier address for the PnP Rule. This is most likely to be an IP Address

diagram

```
GlobalAxContentProcessingRuleID
```

type Xs:String

source `<xs:element name="GlobalAxContentProcessingRuleID" type="xs:string" minOccurs="0"/>

element Rule/Definition/PnP_Rule/Distribution

description This section includes the section containing the distribution terminal identifier address for the PnP Rule. This is most likely to be an IP Address

diagram

```
GlobalAxContentProcessingRuleID
```

type Xs:String

source `<xs:element name="GlobalAxContentProcessingRuleID" type="xs:string" minOccurs="0"/>

likely to be an IP Address

element Rule/Definition/PnP_Rule
diagram

type Xs:String
source
<xs:element name="Programme_Type" minOccurs="0">
    <xs:simpleType>
        <xs:restriction base="xs:string">
            <xs:enumeration value="OnDemand" />
            <xs:enumeration value="Object" />
            <xs:enumeration value="Programme" />
        </xs:restriction>
    </xs:simpleType>
</xs:element>
description This section includes the section containing the distribution terminal identifier address for the PnP Rule. This is most likely to be an IP Address

element Rule/Definition/PnP_Rule/Arguments
diagram

children Start_Date Start_Time Duration_Time ChannelID TerminalID Description selection AXOID
source
<xs:element name="Arguments" minOccurs="0" maxOccurs="unbounded">
    <xs:complexType>
        <xs:sequence>
            <xs:element name="Start_Date" type="xs:date"/>
            <xs:element name="Start_Time" type="xs:time"/>
            <xs:element name="End_Date" type="xs:date"/>
            <xs:element name="End_Time" type="xs:time"/>
            <xs:element name="ChannelID" type="xs:string" minOccurs="0"/>
            <xs:element name="TerminalID" type="xs:string" minOccurs="0"/>
            <xs:element name="AxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
            <xs:element name="AxContentProcessingParam" minOccurs="0" maxOccurs="unbounded">
                <xs:complexType>
                    <xs:simpleContent>
                        <xs:extension base="xs:string">
                            <xs:attribute name="ParameterName" type="xs:string" use="required"/>
                        </xs:extension>
                    </xs:simpleContent>
                </xs:complexType>
            </xs:element>
        </xs:sequence>
    </xs:complexType>
</xs:element>
This section includes the section containing the description of a distribution argument specifying how, where and when an AXMEDIS object is to be distributed.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![Start_Date](start_date_diagram)

- **Type** `xs:Date`
- **source** `<xs:element name="Start_Date" type="xs:date"/>

- **description** This defines the start date for the distribution of an AXMEDIS Object or Selection.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![Start_Time](start_time_diagram)

- **Type** `xs:Time`
- **source** `<xs:element name="Start_Time" type="xs:time"/>

- **description** This defines the start time for the distribution of an AXMEDIS Object or Selection.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![Duration_Time](duration_time_diagram)

- **Type** `xs:Time`
- **source** `<xs:element name="Duration_Time" type="xs:time" minOccurs="0"/>

- **description** This defines the duration time for the distribution of an AXMEDIS Object or Selection.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![ChannelID](channel_id_diagram)

- **Type** `xs:String`
- **source** `<xs:element name="ChannelID" type="xs:string" minOccurs="0"/>

- **description** This defines the distribution channel if different from the global distribution for the P&P Programme.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![TerminalID](terminal_id_diagram)

- **Type** `xs:String`
- **source** `<xs:element name="TerminalID" type="xs:string" minOccurs="0"/>

- **description** This defines the distribution terminal if different from the global terminal id for the P&P Programme.

**element Rule/Definition/PnP_Rule/Arguments**

- **diagram**
  
  ![AxContentProcessingRuleID](ax_content_processing_rule_id_diagram)

- **Type** `xs:String`
- **source** `<xs:element name="AxContentProcessingRuleID" type="xs:string" minOccurs="0"/>
description This defines the Content Processing Rule ID to adapt the AXMEDIS Object if different from the global terminal id for the P&P Programme

element Rule/Definition/PnP_Rule/Arguments
diagram
Type xs:String
source <xs:element name="AxContentProcessingParam" type="xs:string" minOccurs="0"/>
description This defines the Content Processing Paramters for the AXCP Rule

element Rule/Definition/PnP_Rule/Arguments
diagram
Type xs:String
source <xs:element name="Description" type="xs:string" minOccurs="0"/>
description This element holds a description of the object defined by the user to describe the object such as name of the object etc

element Rule/Definition/PnP_Rule/Arguments
Diagram
Type xs:String
Source <xs:element name="AXOID" type="xs:string" minOccurs="0"/>
description This element holds a description of the object defined by the user to describe the object such as name of the object etc

9 Formal description of communication protocol between the P&P Editor and Workflow

9.1 Program Publication User Interface method (Rule Editor Channel)

GET{ServiceURI}? Credentials="Credential string"
&AXRQID="Request ID string"
&Program_Name="Program Name string"
&URI="UserListenerService string"

Program_Name contains the P&P Programme XML to be edited
Credentials contains user Credentials.
AXRQID is the unique identifier to the Request, to be returned in following notifications from the Response Gateway
URI is the URI where the Response Adapter waits for notifications from the Response Gateway

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:
<xml version="1.0" encoding="UTF-8">
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
<xs:element name="Rule_editor_Response">
<xs:complexType>
  <xs:sequence>
    <xs:element name="result" type="xs:boolean"/>
    <xs:element name="errmsg" type="xs:string" nillable="true" minOccurs="0"/>
    <xs:element name="errorcode" type="xs:int"/>
    <xs:element name="programid" type="xs:string" minOccurs="0" maxOccurs="20"/>
  </xs:sequence>
</xs:complexType>
</xs:element>
</xs:schema>

PnP User Interface

<table>
<thead>
<tr>
<th>Method</th>
<th>bool PnPUI();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call coming from Workflow Request Gateway. This method will allow the workflow engine to invoke the PnP Program Editor to edit a program as specified by its name.</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char *AXRQID, char *userCredentials, char *programName, char *URI</td>
</tr>
<tr>
<td>Output parameters</td>
<td>bool</td>
</tr>
</tbody>
</table>

**Request Sample Message**

```
<message name="PnPUIRequest">
  <part name="ProgramName" element="s0:ProgramName"/>
  <part name="UserCredentials" element="s0:UserCredentials"/>
  <part name="AXRQID" element="s0:AXRQID"/>
  <part name="REListenerService" element="s0:REListenerService"/>
</message>
```

**Response Sample Message**

```
<xs:element name="REResult">
  <xs:complexType>
    <xs:sequence>
      <xs:element name="Result" type="xs:boolean"/>
      <xs:element name="ErrorMSG" type="xs:string" minOccurs="0"/>
      <xs:element name="ErrorCode" type="xs:string" minOccurs="0" maxOccurs="20"/>
      <xs:element name="ProgramList" type="xs:string" minOccurs="0" maxOccurs="20"/>
    </xs:sequence>
  </xs:complexType>
</xs:element>
```

**9.2 Activate Program Publication method (Rule Editor Channel)**

GET{ServiceURI}? Credentials="Credential string" &AXRQID="Request ID string" &ProgramID="ProgramID string" &URI="EngineListenerService string"

**ProgramID** contains the ID of the program to be activated.

**Credentials** contains user Credentials.

**AXRQID** is the unique identifier to the Request, to be returned in following notifications from the Response Gateway.

**URI** is the URI where the Response Adapter waits for notifications from the Response Gateway.

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:
```
<?xml version="1.0" encoding="UTF-8"?>
```
Activate PnP

<table>
<thead>
<tr>
<th>Method</th>
<th>bool activatePnP();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call coming from Workflow Request Gateway. This method will allow the workflow engine to activate a program inside the PnP Engine through PnP Editor.</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char <em>AXRQID, char <em>userCredentials, char</em> programID, char</em> URI</td>
</tr>
<tr>
<td>Output parameters</td>
<td>Bool</td>
</tr>
</tbody>
</table>

Request Sample Message

```xml
<message name="ActivatePnPRequest">
  <part name="ProgramID" element="s0:ProgramID"/>
  <part name="UserCredentials" element="s0:UserCredentials"/>
  <part name="AXRQID" element="s0:AXRQID"/>
  <part name="ReListenerService" element="s0:REListenerService"/>
</message>
```

Response Sample Message

```xml
<x:complexType>
  <x:sequence>
    <x:element name="Result" type="xs:boolean"/>
    <x:element name="ErrorMSG" type="xs:string" minOccurs="0"/>
    <x:element name="ErrorCode" type="xs:string" minOccurs="0" maxOccurs="20"/>
    <x:element name="ProgramList" type="xs:string" minOccurs="0" maxOccurs="20"/>
  </x:sequence>
</x:complexType>
```

9.3 Notify Completion Program Publication method (Rule Editor Response Channel)

Notify Completion

<table>
<thead>
<tr>
<th>Method</th>
<th>bool notifyCompletion();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call going to the Workflow Request Gateway. This method will allow the PnP Editor to notify the completion of a job</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char* AXRQID, char* URI, char* endpURL, bool result=true, char* errorCode, char* errorMSG, char* ProgramID, char* xmlRuleSchema</td>
</tr>
<tr>
<td>Output parameters</td>
<td>Bool</td>
</tr>
</tbody>
</table>

Request

```xml
<message name="RENotificationRequest">
</message>
```
Sample Message

```xml
<message>
  <part name="AXRQID" element="s0:AXRQID"/>
  <part name="URI" element="s0:URI"/>
  <part name="Result" element="s0:Result"/>
  <part name="ErrorCode" element="s0:ErrorCode"/>
  <part name="ErrorMSG" element="s0:ErrorMSG"/>
  <part name="RuleSchema" element="s0:RuleSchema"/>
</message>
```

Response Sample Message

```xml
<xs:element name="MethodResponse">
  <xs:complexType>
    <xs:sequence>
      <xs:element name="Result" type="xs:boolean"/>
      <xs:element name="ErrorCode" type="xs:string" minOccurs="0"/>
      <xs:element name="ErrorMSG" type="xs:string" minOccurs="0" maxOccurs="0"/>
    </xs:sequence>
  </xs:complexType>
</xs:element>
```

10 Formal description of communication protocol between the P&P Engine and Workflow

10.1 Status Request to Program and Publication method (Engine Channel)

GET{ServiceURI}? Credentials="Credential string"&AXRQID="Request ID string"
&ProgramID="Program ID string"

Credentials contains user Credentials.
AXRQID is the unique identifier to the Request, to be returned in following notifications from the Response Gateway
ProgramID is the ID of the Program whose status is to be returned

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
  <xs:element name="Engine_Response">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="result" type="xs:boolean"/>
        <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0" maxOccurs="100"/>
        <xs:element name="errorcode" type="xs:int" minOccurs="0" maxOccurs="100"/>
        <xs:element name="ruleid" type="xs:string" minOccurs="0" maxOccurs="20"/>
        <xs:element name="status" type="xs:string" minOccurs="0" maxOccurs="100"/>
        <xs:element name="xml_rule_schema" type="xs:string" minOccurs="0" maxOccurs="100"/>
        <xs:element name="rulelog" type="xs:string" minOccurs="0" maxOccurs="100"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```

<table>
<thead>
<tr>
<th>Call name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>

AXMEDIS Project
**10.2 Suspend Program and Publication method (Engine Channel)**

GET{ServiceURI}? Credentials="Credential string"&AXRQID="Request ID string"  
&ProgramID="Program ID string"

_Credentials_ contains user Credentials.  
_AXRQID_ is the unique identifier to the Request, to be returned in following notifications from the Response  
_Gateway_  
_ProgramID_ is the ID of the Program to be suspended

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:

```
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
  <xs:element name="Engine_Response">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="result" type="xs:boolean"/>
        <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0" />
        <xs:element name="errorcode" type="xs:int"/>
        <xs:element name="ruleid" type="xs:string" minOccurs="0" maxOccurs="20"/>
        <xs:element name="status" type="xs:string" minOccurs="0" />
        <xs:element name="xml_rule_schema" type="xs:string" minOccurs="0" maxOccurs="100"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```

**10.3 Abort Program Publication method (Engine Channel)**

GET{ServiceURI}? Credentials="Credential string"&AXRQID="Request ID string"  
&ProgramID="Program ID string"

_Credentials_ contains user Credentials.  
_AXRQID_ is the unique identifier to the Request, to be returned in following notifications from the Response  
_Gateway_  
_ProgramID_ is the ID of the Program to be aborted

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:

```
<?xml version="1.0" encoding="UTF-8"?>
```
<xs:element name="Engine_Response">
  <xs:complexType>
    <xs:sequence>
      <xs:element name="result" type="xs:boolean" />
      <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0" />
      <xs:element name="errorcode" type="xs:int" />
      <xs:element name="ruleid" type="xs:string" minOccurs="0" maxOccurs="20" />
      <xs:element name="status" type="xs:string" minOccurs="0" />
      <xs:element name="xml_rule_schema" type="xs:string" minOccurs="0" />
      <xs:element name="rulelog" type="xs:string" minOccurs="0" maxOccurs="100" />
    </xs:sequence>
  </xs:complexType>
</xs:element>
</xs:schema>

Call name

<table>
<thead>
<tr>
<th>Method</th>
<th>bool AbortPnPProgram();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call coming from Workflow Request Gateway. This method will allow the workflow engine to abort a program in the PnP engine.</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char *AXRQID, char *userCredentials, char *ProgramID</td>
</tr>
<tr>
<td>Output parameters</td>
<td>bool</td>
</tr>
<tr>
<td>Request Sample Message</td>
<td></td>
</tr>
<tr>
<td>Response Sample Message</td>
<td></td>
</tr>
</tbody>
</table>

10.4 Resume Program Publication method (Engine Channel)

GET{ServiceURI}? Credentials="Credential string"&AXRQID="Request ID string" &ProgramID="Program ID string"&URI="EngineListenerService string"

Credentials contains user Credentials.
AXRQID is the unique identifier to the Request, to be returned in following notifications from the Response Gateway
ProgramID is the ID of the Program to be resumed
URI is the URI where the Response Adapter waits for notifications from the Response Gateway

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
  <xs:element name="Engine_Response">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="result" type="xs:boolean" />
        <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0" />
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```
### Call name

<table>
<thead>
<tr>
<th>Method</th>
<th>bool ResumePnPProgram();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call coming from Workflow Request Gateway. This method will allow the workflow engine to resume a program in the PnP engine.</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char *AXRQID, char *userCredentials, char *ProgramID, char *URI</td>
</tr>
<tr>
<td>Output parameters</td>
<td>bool</td>
</tr>
<tr>
<td>Request Sample Message</td>
<td></td>
</tr>
<tr>
<td>Response Sample Message</td>
<td></td>
</tr>
</tbody>
</table>

#### 10.5 Activate Program Publication method (Engine Channel)

GET [ServiceURI]? Credentials="Credential string"&AXRQID="Request ID string"
&ProgramID="Program ID string"&URI="EngineListenerService string"

**Credentials** contains user Credentials.  
**AXRQID** is the unique identifier to the Request, to be returned in following notifications from the Response Gateway.  
**ProgramID** is the ID of the Program to be activated.  
**URI** is the URI where the Response Adapter waits for notifications from the Response Gateway.

The response to the invoked method is sent via an http GET response. The response is XML coded, following the schema:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs ="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
  <xs:element name="Engine_Response">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="result" type="xs:boolean"/>
        <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0"/>
        <xs:element name="errorcode" type="xs:int"/>
        <xs:element name="ruleid" type="xs:string" minOccurs="0" maxOccurs="20"/>
        <xs:element name="status" type="xs:string" minOccurs="0" maxOccurs="20"/>
        <xs:element name="xml_rule_schema" type="xs:string" minOccurs="0" maxOccurs="100"/>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```
10.6 Workflow Notification Method (Engine Response Channel)

GET {EngineListenerServiceURI}? Credentials="Credential string"&AXRQID="Request ID string" &Status="Status string"

- **Credentials** contains user Credentials.
- **AXRQID** is the unique identifier to the Request, to be returned in following notifications from the Response Gateway.
- **Status** is a string containing the Notification from the Workflow process.

The response to the invoked method is sent via an HTTP GET response. The response is XML coded, following the schema:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault="qualified" attributeFormDefault="unqualified">
  <xs:element name="Engine_Response">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="result" type="xs:boolean" />
        <xs:element name="errormsg" type="xs:string" nillable="true" minOccurs="0" />
        <xs:element name="errorcode" type="xs:int" />
        <xs:element name="ruleid" type="xs:string" minOccurs="0" maxOccurs="20" />
        <xs:element name="status" type="xs:string" minOccurs="0" />
        <xs:element name="xml_rule_schema" type="xs:string" minOccurs="0" />
        <xs:element name="rulelog" type="xs:string" minOccurs="0" maxOccurs="100" />
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
```

---

### Call name

<table>
<thead>
<tr>
<th>Method</th>
<th>bool ActivatePnPProgram();</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This method is invoked through a Webservice call coming from Workflow Request Gateway. This method will allow the workflow engine to activate a program in the PnP engine.</td>
</tr>
<tr>
<td>Input parameters</td>
<td>char *AXRQID, char <em>userCredentials, char</em>ProgramID, char *URI</td>
</tr>
<tr>
<td>Output parameters</td>
<td>bool</td>
</tr>
<tr>
<td>Request Sample Message</td>
<td></td>
</tr>
<tr>
<td>Response Sample Message</td>
<td></td>
</tr>
</tbody>
</table>
### 11 Conclusion

This part, DE3-1-2-3-11, includes the specification of components, formats, databases and protocol related to the AXMEDIS Framework area Programme and Publication (P&P) including the P&P Model, P&P Editor, P&P Engine and P&P Engine Monitor.

This report is an update of DE3-1-2-2-11 and includes the following updates and revisions:
- Updates of the GUIs (P&P Editor and P&P Engine Monitor)
- Update of the P&P Model to handle different P&P Programme types, AXCP content processing and status of AXMEDIS objects during distribution
- Minor revision to the Use Cases
- Updates to the configuration parameters to handle the updated functionalities of the P&P Tools
- Revision of the error reporting
- Revision and update of the module design (UML diagrams)

### 12 Bibliography (mandatory)


13 Glossary

13.1 List of AXMEDIS Acronyms for Identification

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXOID</td>
<td>unique AXMEDIS Object ID</td>
</tr>
<tr>
<td>AXPnP</td>
<td>Defines the AXRID as a P&amp;P Programme</td>
</tr>
<tr>
<td>AXRID</td>
<td>unique AXMEDIS Rule ID</td>
</tr>
</tbody>
</table>

13.2 List of AXMEDIS Acronyms for Tools

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXCP</td>
<td>AXMEDIS Content Processing</td>
</tr>
<tr>
<td>AXDBM</td>
<td>AXMEDIS Database Manager</td>
</tr>
<tr>
<td>AXDOM</td>
<td>AXMEDIS Domain (associated to the PMS Home managing the Domain)</td>
</tr>
<tr>
<td>AXFW</td>
<td>AXMEDIS Framework</td>
</tr>
<tr>
<td>AXMEDIS</td>
<td>the project</td>
</tr>
<tr>
<td>AXOB</td>
<td>AXMEDIS Object, they does not contain the license. An AXOB with a license is presently called Governed AXOB.</td>
</tr>
<tr>
<td>AXOM</td>
<td>AXMEDIS Object Manager</td>
</tr>
<tr>
<td>AXQS</td>
<td>AXMEDIS Query Support</td>
</tr>
<tr>
<td>AXWFM</td>
<td>AXMEDIS workflow Manager</td>
</tr>
<tr>
<td>GAXOB</td>
<td>Governed AXMEDIS Object</td>
</tr>
<tr>
<td>P&amp;P</td>
<td>AXMEDIS Programme and Publication</td>
</tr>
</tbody>
</table>

13.3 AXMEDIS Programme and Publication (P&P) Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>P&amp;P Editor</td>
<td>AXMEDIS Programme and Publication Editor for creating, manipulating and saving Programme and Publication programmes</td>
</tr>
<tr>
<td>P&amp;P Engine</td>
<td>AXMEDIS Programme and Publication Engine for the processing of activated P&amp;P Programmes for distribution. It is connected to the AXMEDIS distribution servers and uses AXMEDIS Factory resources for AXMEDIS Content Processing area and for retrieving AXMEDIS Objects</td>
</tr>
<tr>
<td>P&amp;P Programme</td>
<td>Programme and Publication rule(s) in XML format specifying a set of naceousary parameters for the distribution of the specified objects such as start time and date,</td>
</tr>
</tbody>
</table>
### 13.4 AXMEDIS Workflow Management Systems Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXRQID</td>
<td>A composite parameter as a subtype of WF-Exchange_ID that can be passed between the AXWF and relevant AXMEDIS components to help identify a particular WF-Exchange_ID.</td>
</tr>
<tr>
<td>Exchange_Instance</td>
<td>A particular exchange messaging act or communication between any relevant AXMEDIS components and AXWF within a workflow-instance.</td>
</tr>
<tr>
<td>Response_ID</td>
<td>A composite parameter as a subtype of WF-Exchange_ID that can be passed from any relevant AXMEDIS components to help identify a particular WF-Exchange_ID as a response to a particular AXRQID.</td>
</tr>
</tbody>
</table>